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Micro Focus Enterprise Developer 2.3
Update 1 for Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer for Visual Studio 2012 in the product Help.
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Installation

System Requirements

Hardware Requirements
Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Windows

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

UNIX

The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus installer 479 1.91 GB 958 36.5

HP IA Micro Focus installer 866 3.46 GB 1730 69

System Z
running Red
Hat Linux

Micro Focus installer 390 1.56 GB 780 36

x86-64
running Red
Hat Linux

Micro Focus installer 431 1.72 GB 862 46
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

SPARC
running
Solaris

Micro Focus installer 492 1.97 GB 984 40

System Z
running SUSE
SLES

Micro Focus installer 394 1.58 GB 788 36

x86-64
running SUSE
SLES

Micro Focus installer 437 1.75 GB 874 46

Operating Systems Supported
Note: If you are using Enterprise Developer on a 64-bit operating system, you can produce either 32-
bit or 64-bit applications.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

Note:

• The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

• Besides the software listed below, the setup file also installs the 32-bit Java 8 Update 51.

Visual Studio IDE

This product requires Microsoft's Visual Studio - either the Visual Studio Integrated Shell or a more
advanced version of Visual Studio.

The following advanced editions of Visual Studio are required:

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)

If there is no Visual Studio installed on your machine, the setup file for Enterprise Developer for Visual
Studio 2012 or 2013 will install the Visual Studio Integrated Shell.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Enterprise Developer for Visual Studio 2013.
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• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.

• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

• Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the
Shell has a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not
included in the setup for Enterprise Developer for Visual Studio 2015 and before you start the
installation, ensure that there is an advanced edition of Visual Studio 2015 installed on your
machine.

Note:

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If you

choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or
the Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for
more details.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing
Enterprise Developer on a machine that has no Visual Studio 2013 installed, the setup file installs Visual

Installation | 7

http://www.microfocus.com/docs/links.asp?vc=RyuJIT_advisory
http://www.microfocus.com/docs/links.asp?vc=RyuJIT_advisory
http://www.microfocus.com/docs/links.asp?vc=RyuJIT_testing
http://www.microfocus.com/docs/links.asp?vc=mskb3088955
http://www.microfocus.com/docs/links.asp?vc=mskb3088956
http://www.microfocus.com/docs/links.asp?vc=mskb3088957
http://www.microfocus.com/docs/links.asp?vc=mskb3088957
http://www.microfocus.com/docs/links.asp?vc=mskb3093266
http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1
http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1
http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1
http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1


Studio 2013 Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's
Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

UNIX/Linux:

These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On SUSE 11, you must have the following operating system libraries installed:

Additional libraries for Micro Focus Enterprise
Developer Unix Components

Library Platform

SUSE 11

glibc-locale-32bit

gcc (gcc-32-bit)

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

All Enterprise Developer
products

gcc*.i686
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries required to
use the core_on_error runtime
variable

gdb - the gdb packages (for the GNU Project Debugger) can be
installed from the install media for your OS.

Additional libraries for Micro
Focus Enterprise Developer Unix
Components

gcc*.i686
gcc*.s390
glibc-*.s390
glibc-*.s390x
glibc-devel-*.x86_64
glibc-devel-*.i686
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.
• On SUSE and Red Hat, PL/I support requires that you have the following operating system libraries

installed:

libelf-devel-0.137-8.19
libelf1-0.137-8.19
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libelf1-32bit-0.137-8.19

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The setup file installs Java 8 u51 32-bit. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server JCA support for Enterprise Server
• COBOL on Microsoft Azure on page 10
• Java Development Kit (JDK) on page 10
• Database Access on page 11
• Database Access - COBSQL (Pro*COBOL) on page 11
• Database Access - OpenESQL on page 11
• Database Access - HCO for SQL Server (HCOSS)
• Database Access - HCO for DB2 LUW on page 13
• Enterprise Server for .NET on page 15
• Mainframe Access - Endevor Support
• Micro Focus Rumba on page 15
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• WebSphere MQ on page 15
• Windows Forms on page 15

Application server JCA support for Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE COBOL RA CICS RA

JBoss 5.1.0 1.6 (Oracle) 5 X

JBoss 6.1.0 1.6 (Oracle) 6 X

JBoss 7.1.1 1.7 (Oracle) 6 X X

Oracle WebLogic
10.3.5

1.6 (Oracle) 5 X

Oracle WebLogic
12.1.1

1.6/1.7 (Oracle) 6 X

IBM WebSphere 7.0 1.5 (IBM) 5 X

IBM WebSphere 8.0 1.6 (IBM) 6 X

IBM WebSphere 8.5 1.6/1.7 (IBM) 6 X X

COBOL on Microsoft Azure

Back to Top

Microsoft Azure requires additional software. See the Microsoft Microsoft Azure web site for a full list of the
required software, but the following is a summary of the main prerequisites:

• Windows 7 Service Pack 1, Windows 8, Windows 8.1, Windows Server 2008 R2 SP1, Windows Server
2012, Windows Server 2012 R2. (Windows 7 Home Basic is not supported.)

• Microsoft Azure Tools version 2.6 for the version of Visual Studio you have installed - this includes the
Microsoft Azure SDK

• Visual Studio's Visual Web Developer feature
• IIS7 with ASP.NET and WCF HTTP Activation, Static Content, IIS Management Console and HTTP

Redirection.
• Microsoft's Web Deployment Tool version 2.1 or later

Java Development Kit (JDK)

Back to Top

Native COBOL and
Java Interoperability

Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to
execute COBOL JVM code and for native COBOL and Java interoperability. The
setup file installs Java 8 u51 32-bit. You can download Oracle's Java EE from 
Oracle's Web site and install it anywhere on your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.
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Interface Mapping
Toolkit (IMTK)

Restriction: This feature applies only when the Enterprise Server feature
is enabled.

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, HCO for SQL Server (HCOSS), or OpenESQL, ensure any third-party software prerequisites
are installed and the environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running
Windows

X X

XA Switch Module The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification
information can be found within the relevant Oracle documentation. If you have an 
Oracle MetaLink account, document # 43208.1 provides details of all language
compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.

Testing For this version, COBSQL was tested with Oracle 11.1, 11.2, and 12.1.

Back to Top

Installation | 11

http://www.microfocus.com/docs/links.asp?vc=oracle-support


Database Access - OpenESQL

Availability Feature/
Platform

Native
and .NET
Managed

COBOL 32-
bit

Native and .NET
Managed COBOL

64-bit

PL/I 32-bit PL/I 64-bit

x86-64
running
Windows

X X X X

XA Switch
Modules

The ODBC One-phase Commit and the SQL Server XA switch modules are provided
and are available on the same platforms as are indicated in the Availability section
above.

To build the SQL Server XA module, you must have the Windows Software
Development Kit (SDK) installed for your version of Windows.

Native
COBOL, .NET
Managed
COBOL, and PL/I

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• OpenESQL supports access to relational databases using compliant .NET
framework drivers (COBOL only)

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

.NET Managed
COBOL

OpenESQL has been tested against the following ADO.NET data providers:

• Microsoft provider for SQL Server
• Microsoft provider for Oracle
• IBM DB2
• Oracle Data Provider for .NET (ODP.NET)
• OleDb
• Managed ODBC .NET providers
• Npgsql PostgreSQL 9.4

SQL CLR
Integration

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:

• Either of the following:

• Visual Studio Shell 2012 Update 1 or later and Microsoft SQL Server Tools
(SSDT SDK)

• Visual Studio 2012 Update 1 or later Professional, Premium, or Ultimate
• Visual Studio Shell 2013 and Microsoft SQL Server Tools (SSDT SDK)
• Visual Studio 2013 Professional, Premium, Ultimate or Community Edition
• Visual Studio Shell 2015 and Microsoft SQL Server Tools (SSDT SDK)
• Visual Studio 2015 Professional, Enterprise or Community Edition

• Any of the following:

• SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR

v2.0 frameworks (2.0, 3.0, 3.5)
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• SQL Azure Database targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET
CLR v2.0 frameworks (2.0, 3.0, 3.5)

Important: The SQL CLR Database project template available in previous
versions of Enterprise Developer is no longer supported. Projects based on
the SQL CLR Database project template are automatically upgraded to use
the SQL Server Database project template when opened in Enterprise
Developer for Visual Studio 2012.

Testing For this version, OpenESQL was tested with:

• Oracle 11.1, 11.2 and 12.1
• DB2 LUW 9.5, 9.7,10.1,10.5
• SQL Server 2008 R2, 2012, 2014
• PostgreSQL 9.4

Note: Micro Focus provides compatibility for PostgreSQL but does not directly
contribute to or support the PostgreSQL open source project. Any issues
relating to PostgreSQL functionality should be addressed through an open
source support vendor.

Database Access - HCO for DB2 LUW

Back to Top

Availability Feature/
Platform

Native
COBOL
32-bit

Native COBOL
64-bit

PL/I 32-bit PL/I 64-bit

x86-64
running
Windows

X X X X

XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM DB2 Connect - Personal, Enterprise, Application Server or Unlimited
Edition

• IBM DB2 LUW - Workgroup or Enterprise Server Editions including Advanced
versions

• IBM DB2 LUW - Express or Express-C Edition
• IBM Data Server Client (assumes installation of a remote DB2 LUW Server

product)
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Testing For this version, HCO for DB2 LUW was tested with DB2 LUW 9.5, 9.7, 10.1, and
10.5.

HCO for SQL Server (HCOSS)

Back to Top

Microsoft SQL
Server

SQL Server 2008 R2 or later, Developer or Enterprise Editions, including Microsoft SQL
Server Management Studio.

Database
Migration

• Microsoft .NET Framework 4.0
• Microsoft SQL Server Integration Services - available with the Microsoft SQL Server

editions listed above
• Microsoft OLE DB Provider for DB2, available in the SQL Server 2008 R2 or later

Feature Pack

Note: Be sure to configure the OLE DB Provider to connect to the mainframe.
See your Microsoft documentation for details.

• Mainframe DB2

Note:

• We support only the mainframe DB2 versions that are currently under IBM
support.

• If you intend to develop applications on your local machine, but deploy
applications to a SQL Server database on a remote machine, you can install
SQL Server Native Client 10.x (or later) for ODBC connectivity on your local
machine instead of installing SQL Server. For SQL Server 2014 connectivity,
you can install Microsoft ODBC Driver 11.0 for SQL Server. For information on
configuring a deployment machine, see the section Deploying Native
Applications below.

Application
Migration

ADO.NET
applications

ADO.NET applications require either of the following
combinations:

• SQL Server 2008 R2 and SqlClient Data Provider in .NET
Framework 3.5

• SQL Server 2012 or later and SqlClient Data Provider in .NET
Framework 4.0, or 4.5 (4.x is preferred)

COBOL Stored
Procedures

See the requirements specified in the SQL CLR Integration
section under Database Access - OpenESQL in this topic.

Deploying
Native
Applications

Development
Machine

• Enterprise Developer for Visual Studio 2012
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

Development
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the development
machine, but is not required to be

Deployment
Machine

• Enterprise Server or Enterprise Test Server installed
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
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For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

If you want to bind your application from the deployment machine,
install the following software in addition:

• Microsoft .NET 3.5 framework, or later
• SQL Server 2008 R2 or later System CLR Types
• SQL Server 2008 R2 or later Shared Management Objects

Deployment
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the deployment
machine, but is not required to be

Testing For this version, HCO for SQL Server was tested with SQL Server 2008 R2, 2012, and
2014.

Enterprise Server for .NET

Back to Top

• Microsoft .NET Framework 4.0
• Microsoft SQL Server 2008 R2. For beta or development installations, SQL Server Express 2008 R2 is

sufficient.

You can download Microsoft's SQL Server from http://www.microsoft.com/sqlserver/en/us/get-sql-
server/try-it.aspx.

• A TN3270 terminal emulator. Micro Focus Rumba is supplied with this product.

Note: You also need to enable IIS and some additional Windows features. Read the Quick Start
section in your Enterprise Server for .NET help for further instructions on how to set up your operating
environment.

Mainframe Access - Endevor Support

Back to Top

• To use the Mainframe Access support for Endevor you must be using Endevor R14 or later. CA
stabilized the Endevor API at R14, so if you upgrade from R14 to a later version you will not need to
update the support module that Mainframe Access uses.

Micro Focus Rumba

Back to Top

• On Windows 8, in order to install Micro Focus Rumba you must have the Microsoft .NET Framework 3.5
Service Pack 1 installed.

WebSphere MQ

Back to Top

IBM WebSphere MQ version 7 and later.

Windows Forms

Back to Top

• Microsoft Visual Studio is required for using the Interface Mapping Toolkit (IMTK) to generate Windows
Forms and ASP.NET Web site test clients.
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• Microsoft Internet Information Service (IIS) is also required for generating Windows Forms test clients.

Additional Software Requirements for Micro Focus
Enterprise Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server JCA support for Enterprise Server on page 16
• Java Development Kit (JDK) on page 17
• Database Access on page 17
• Database Access - COBSQL (Pro*COBOL) on page 17
• Database Access - OpenESQL on page 18
• Database Access - HCO for DB2 LUW on page 19
• WebSphere MQ on page 21

Application server JCA support for Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE

JBoss 5.1.0 1.5/1.6 (Oracle) 5

JBoss 6.1.0 1.6 (Oracle) 6

JBoss 7.1.1 1.7 (Oracle) 6

Oracle WebLogic 10.3.5 1.5 (Oracle) 5

Oracle WebLogic 12.1.1 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

The availability of resource adapters for these Application Servers differs between UNIX platforms. The
following table indicates where support is available for each platform:

Feature/
Platform

JBoss
5.1.0

JBoss
6.1.0

JBoss
7.1.1

Webspher
e 7.0

Webspher
e 8.0

Webspher
e 8.5

Weblogic
10.3.5

Weblogic
12.1.1

AIX 6.1 on
RS6000

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

HP/UX
11.31 on
Intel IA64

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

64-bit 64-bit 32- and 64-
bit

32- and 64-
bit

16 | Installation



Feature/
Platform

JBoss
5.1.0

JBoss
6.1.0

JBoss
7.1.1

Webspher
e 7.0

Webspher
e 8.0

Webspher
e 8.5

Weblogic
10.3.5

Weblogic
12.1.1

Red Hat
EL 6.2 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Red Hat
EL 5.5 on
AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Solaris 11
on AMD
Opteron

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

Solaris 10
on SPARC

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

SUSE
SLES 11
SP1 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

SUSE
SLES 11
on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Java Development Kit (JDK)

Back to Top

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface
Mapping Toolkit
(IMTK)

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

The JDK is required for generating Java interfaces from the Interface Mapping Toolkit
or the imtkmake command.

EJBs Use the same JDK vendor and version that is used by the application
server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, or OpenESQL, ensure any third-party software prerequisites are installed and the
environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.
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Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SUSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SUSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

Executing On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$ORACLE_HOME/libdir/libclntsh.so       
export LD_PRELOAD

where libdir is:

• lib32 for 32-bit environments
• lib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support. You can find the script in the Micro Focus
Knowledge Base article titled Building and executing Pro*COBOL applications on
UNIX.

Testing For this version, COBSQL was tested with Oracle 11.1, 11.2, and 12.1.

Database Access - OpenESQL

Back to Top
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Availability Feature/
Platform

Native
and .NET
Managed

COBOL 32-
bit

Native and .NET
Managed COBOL

64-bit

PL/I 32-bit PL/I 64-bit

x86-64
running Red
Hat Linux

X X X X

x86-64
running
SUSE Linux

X X X X

IBM System
p running
AIX

X X X

IBM System
z running
SUSE Linux

X X

Itanium
running HP-
UX

X X

x86-64
running
Solaris

X X

SPARC
running
Solaris

X X X X

Native
COBOL

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

Testing For this version, OpenESQL was tested with:

• Oracle 11.1, 11.2 and 12.1
• DB2 LUW 9.5, 9.7,10.1,10.5
• SQL Server 2008 R2, 2012, 2014
• PostgreSQL 9.4 on the following platforms only:

• x86-64 running Red Hat Linux
• x86-64 running SUSE Linux

Note: Micro Focus provides compatibility for PostgreSQL but does not directly
contribute to or support the PostgreSQL open source project. Any issues relating to
PostgreSQL functionality should be addressed through an open source support
vendor.

Database Access - HCO for DB2 LUW

Back to Top
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Availability Feature/
Platform

Native
COBOL 32-

bit

Native COBOL
64-bit

PL/I 32-bit PL/I 64-bit

x86-64
running
Red Hat
Linux

X X X X

x86-64
running
SUSE
Linux

X X X X

IBM
System p
running AIX

X X X

IBM
System z
running
SUSE
Linux

X X

Itanium
running
HP-UX

X

x86-64
running
Solaris

SPARC
running
Solaris

X X X X

XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. You can find IBM document
certification information for DB2/COBOL applications within the IBM Information
Center for DB2, in the topic Support for database application development in
COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later
• On SPARC running Solaris, 64-bit is supported in IBM versions 10.1 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM DB2 Connect - Personal, Enterprise, Application Server or Unlimited Edition
• IBM DB2 LUW - Workgroup or Enterprise Server Editions including Advanced

versions
• IBM DB2 LUW - Express or Express-C Edition
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• IBM Data Server Client (assumes installation of a remote DB2 LUW Server
product)

Testing For this version, HCO for DB2 LUW was tested with DB2 LUW 9.5, 9.7, 10.1, and
10.5.

WebSphere MQ

Back to Top

IBM WebSphere MQ version 7 and later.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer for Visual Studio , the machine does not have Microsoft Visual
C++ Redistributable Runtime already installed, it is installed as required by Enterprise Developer. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2012, the machine does not have Microsoft
Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2015, the machine does not have Microsoft
Visual C++ 2013 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
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Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing Enterprise Developer for Visual Studio

Downloading the Product
You can download Enterprise Developer from the Micro Focus SupportLine Web site and from the Product
Updates section.

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installing and Licensing Micro Focus Rumba
The Enterprise Developer setup file includes Micro Focus Rumba 9.4 which you can install as an optional
component. The license for Enterprise Developer also licenses all components of Rumba (for example,
Rumba Office, Rumba for Mainframe, UNIX, AS400, and the TN3270 mainframe display within Enterprise
Developer).

Note: Micro Focus Rumba versions 8.3 or later provide integration with Enterprise Developer where
you can use a Rumba TN3270 Mainframe Display within the IDE in order to run applications.

Installation considerations:

• If you are installing Enterprise Developer onto a machine that does not have Rumba installed, it is
recommended that you select the Rumba option when you start the installation. This installs all of the
components of Rumba including the one you need to establish a mainframe 3270 connection (Rumba
for Mainframe).

• Installing Rumba 9.4 as part of this release of Enterprise Developer will update any older version of
Rumba installed and licensed on your machine.

Note: Micro Focus recommends that you upgrade older versions of Rumba to the one installed
with Enterprise Developer. However, if you want to keep an older version of Rumba, you can
choose not to install Rumba when you start the Enterprise Developer installation. In this case, the
TN3270 Mainframe Display will not be available for use from within Enterprise Developer.

• If a version of Rumba more recent than version 9.4 is installed and licensed on your machine, you can
choose not to install Rumba as part of the Enterprise Developer installation. The TN3270 Mainframe
Display provided with this version of Rumba may be supported within Enterprise Developer but might
not have been tested.
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Installing as an Upgrade
• This release will not upgrade previous versions of the product. Any previous releases and HotFixes of

the product installed on your machine must be uninstalled before installing 2.3.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing
Note:

• This version of the product is a full install.
• Before installing, check Installation Restrictions and Requirements. Also, see Installing as an

Upgrade first for important information, if you have an earlier version of Enterprise Developer
installed on your machine.

To install this product:

1. Run the edvs2012_23.exe file (or edvs2013_23.exe, edvs2015_23.exe) and follow the wizard
instructions to install the prerequisite software and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2012_23.exe which contains a number of product .msi files
(Windows Installer packages). When run, edvs2012_23.exe performs some initial system checks then
sequentially installs the .msi files.
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Note: The following applies to edvs2013_23.exe when installing the product for Visual Studio 2013.
The following applies to edvs2015_23.exe when installing the product for Visual Studio 2015.

edvs2012_23.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
edvs2012_23.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
edvs2012_23.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
edvs2012_23.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
edvs2012_23.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
edvs2012_23.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2012_23.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Installing from a Server
There are two methods for installing this product on users' machines using a server. You can:

• Copy the product onto the server and then use Setup under control of a third-party software distribution
package, such as Microsoft's Systems Management Server (SMS), to install the product onto multiple
users' machines.
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This method of installation and the associated file are not supported by Micro Focus. They are provided
on an "as is" basis and have not been tested in any form. You can use them at your own discretion.

• Install onto the server. Then users run Setup to install from the server onto their own machines.

Both methods give you control of what options the user can install and mean you do not have to send the
installation media to every user, as they install from the server instead.

Installing on Microsoft Terminal Server and Citrix
Note: This document is a work-in-progress. Check the documentation for Enterprise Developer in the
Product Documentation section of the Enterprise Developer SupportLine Web site for its most recent
version.

Microsoft Terminal Server and Citrix (TS/Citrix) are environments for running multiple instances of a single
user product. They are not platforms where a single-user product can be made to perform as a multi-user
product.

When running Enterprise Developer on TS/Citrix machine, there might be some implications to
components of Enterprise Developer which could cause potential conflicts between a ‘per-user session’
compared to the standard ‘per machine’ setup. The following components of Enterprise Developer require
special configuration:

• Eclipse workspaces and projects
• The Enterprise Server component - the Run-Time System product for JCL, CICS and IMS operations
• The database management service

You can use Enterprise Developer with TS or with any Citrix version certified for use with Visual Studio;
however, a separate end-user license is required for each user who accesses Enterprise Developer, even if
it is running on a single machine. See your End User License Agreement for clarification.

Note: Micro Focus Enterprise Developer does not officially support TS/Citrix. However, it will run on
any prerequisite Operating System that is supported under TS/Citrix.

Capacity planning

Multi-user capacity planning for TS/Citrix does not scale linearly, and the calculations required for this
planning are not directly related or specific) to any Micro Focus technology. Micro Focus recommends that
you consult with Microsoft or Citrix Systems, respectively, about the server sizing and capacity planning,
based on hosting the required number of “rich” Windows 7 or Windows 8 desktops (e.g. using a singleton
desktop build as a baseline).

Installing Enterprise Developer

To install Enterprise Developer for use with TS/Citrix:

1. Log on to the physical terminal or Citrix server with a user ID that has administrator privileges.
2. Use the download links in your Electronic Product Delivery email.
3. Follow the links for the installation instructions and the End User License Agreement.

Configuring Enterprise Developer components

Further configuration is required for the following Enterprise Developer components:

Customizing the installation of Enterprise Developer for Visual Studio

On TS/Citrix, end-users accessing an application get their own copy (called a "clone") of an initial set of the
application's configuration settings. Within their clone of the application, each end-user is then able to apply
some changes to the initial configuration settings - for example, change any color and font settings, the
screen-layout of windows, some of the shortcut keys among others. The modified settings are then
preserved on a per-user basis.
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This mechanism enables you to customize the configuration settings within the initial Enterprise Developer
installation which is then replicated at the individual users's machines when they are using a clone of the
application. While this does not prevent the developers from changing the initial settings within their clone
of the application, it does favor team work by providing all team members with a preconfigured
environment, that has the same settings, behavior and look as a start.

Follow the steps below to customize Enterprise Developer for Visual Studio on the TS/Citrix machine and
apply the changes to the clones of the product.

Caution: The following instructions involve changing the registry settings on the TS/Citrix machine.
Take extra care when editing the registry as incorrect entries might corrupt your system. It is
recommended that you back up any valued data on your computer in advance. Micro Focus
recommends you also create a backup copy of the master location, after step 8. Alternatively, copy
EDsettings.reg to a safe location.

1. Log onto the TS/Citrix machine as a TS/Citrix administrator.
2. Install Enterprise Developer.

TS/Citrix stores a collection of settings in the server's registry, under HKEY_LOCAL_MACHINE
\Software\Microsoft\Windows NT\CurrentVersion\Terminal Server\Install
\Software\xxxx. This document refer to this location as the master location.

Note: The Enterprise Developer settings are stored under different locations in the registry. For
example:

• HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\11.0\MicroFocus
\Settings - stores the options specified in Tools > Options.

• HKEY_CURRENT_USER\Software\Micro Focus\Visual COBOL\2.3\Interface
Mapping Toolkit - stores the settings for IMTK

• HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\11.0\MicroFocus
\COBOL Tools\Client Generation - stores the settings for IMTK client generation

Micro Focus recommends you create a backup copy of any settings in the master location, after step 8.
Alternatively, copy EDsettings.reg to a safe location.

3. Log off from the TS/Citrix account.
4. Log on as a user that has the privileges of the standard end-user (a developer).

TS/Citrix now clones the contents of the master location to HKEY_CURRENT_USER\Software\xxxx.
This document refers to this location as the user location.

5. Customize Enterprise Developer as required for a first time user within your development teams -
modify any default settings, default layout of views within Eclipse, etc.

6. Save the user location within the registry:

a. Using the Registry Editor, export the contents of the user location to a file - for example
EDsettings.reg.

b. Edit EDsettings.reg with a plain text editor and replace all HKEY_CURRENT_USER\Software
\xxxx entries with HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT
\CurrentVersion\Terminal Server\Install\Software\xxxx.

For example, replace HKEY_CURRENT_USER\Software\Microsoft\VisualStudio
\11.0\MicroFocus\Settings entries with HKEY_LOCAL_MACHINE\Software\Microsoft
\Windows NT\CurrentVersion\Terminal Server\Install\Software\Microsoft
\VisualStudio\11.0\MicroFocus\Settings.

7. Log off from TS/Citrix.
8. Log on as a TS/Citrix administrator again.
9. Copy the contents of the user location back to the master location:

a. Using the Registry Editor, delete the master location, then import the settings from the
EDsettings.reg file.
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b. Log off from TS/Citrix.

Projects

Create and configure template projects to distribute among your users. Templates must not include fully
qualified paths. You can store the projects in a source control system and make them available so that
individual users can import them into their own workspace.

Enterprise Server Installation Options

When you install Enterprise Developer, the setup file also installs the Enterprise Server component on the
same machine. There are different ways in which you can configure and use Enterprise Server regions in
TS/Citrix environments. This topic outlines two of the methods and explains what the implications of
choosing them are:

• Use the Enterprise Server component as part of Enterprise Developer installed on the TS/Citrix
machine

On the client machines, the developers each use a clone of Enterprise Developer. They also use a
clone of Enterprise Server to create and manage multiple server instances as required.

While this option provides the greatest flexibility, it also consumes the largest footprint per user.

 

 

• Install Enterprise Server or Enterprise Test Server on a separate server

You can install Enterprise Server1 or Enterprise Test Server2 on a separate server that does not have
TS/Citrix installed. By default, Enterprise Server installs and runs as a single-instance product and,
within an Enterprise Server, you can operate a number of server instances. Each server provides
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session and state management for COBOL applications, as well as optionally interfacing with external
resource managers to coordinate resource updates.

There are two ways to provide server instances to the developers using Enterprise Developer on the
TS/Citrix machine:

• Configure and configure one server instance per developer by specifying different ports. We
recommend defining five-digit port numbers where digits one through three identify the developer
and four through five identify a unique port. For example: port number 10123 defines a TN3270
listener for developer 1, and port number 10223 defines a TN3270 listener for developer 2.

This option provides a dedicated enterprise server for testing purposes for each developer, but
restricts each developer to that one enterprise serve instance.

This scenario creates the largest footprint per developer.

Or:
• Create and configure one server instance per application for use by a single development team. Use

a different port number for each instance as explained above, using the first three digits to
differentiate between applications.

 

 

Micro Focus Rumba

1 Micro Focus Enterprise Server provides full application server support for COBOL applications that require
high-performance and mainframe subsystem emulation. Enterprise Server is designed as a multi-user
environment.

2 Micro Focus Enterprise Test Server is an IBM mainframe application test execution environment on
Windows. Enterprise Test Server enables mainframe IT organizations to perform a variety of pre-production
testing on low cost commodity hardware, avoiding unnecessary cost and delay. Built on proven technology,
Enterprise Test Server exponentially expands the test capacity and enables testing to scale up easily to
meet delivery timelines and quality standards driven by today's business requirements.
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To use Micro Focus Rumba on a TS/Citrix machine, ensure you install a license for this type of
environment. Contact Micro Focus Sales for more information.

ViewNow Installation

To use ViewNow on a TS/Citrix machine, ensure you install a license for this type of environment. Contact
Micro Focus Sales for more information.

Windows Compatibility Mode
In Windows Vista and Windows Server 2008, if you have problems starting Enterprise Server instances
using the Micro Focus Enterprise Server Administration HTML GUI, ensure that none of the Enterprise
Server program files are configured to use a Windows compatibility mode. You can check for compatibility
modes by examining the file properties for the program file using Windows Explorer:

1. Open the Properties dialog box for the file.
2. Click the Compatibility tab.
3. Ensure that Run this program in compatibility mode for is not checked.
4. Click Show settings for all users and ensure that Run this program in compatibility mode for is not

checked.
5. Click OK on both dialogs to update the file properties.

Verify that <install-dir>\base\bin\mfds.exe is not set to run in a compatibility mode.

• For 32-bit Enterprise Server, check bin\cas*.exe and bin\mfcs.exe
• For 64-bit Enterprise Server, check bin\win64\cas*.exe and bin\win64\mfcs.exe.

After Installing
You are now ready to run Enterprise Developer. From the Windows taskbar click Start > All Programs >
Micro Focus Enterprise Developer > Enterprise Developer for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8 and Windows Server 2012. You use the Start
screen to invoke programs.

Code
generation
issues in .NET
Framework
version 4.6

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as
part of .NET Framework version 4.6 can result in incorrect execution of some COBOL
code compiled to .NET. Version 4.6 of the .NET Framework is currently shipped as
default with Visual Studio 2015 and Microsoft's Windows 10. The problems include
incorrect execution of MOVE and STRING statements applied to alphanumeric
operands, and incorrect execution of the ROUNDED phrase for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications
compiled to .NET and some can be reproduced in other languages (C# or Visual
Basic).

These problems have been reported and acknowledged by Microsoft and it is our
belief that they either have resolutions or are working on fixes for all of them. For
further information about these issues and guidelines on how to disable the latest
version of the 64-bit JIT compiler, see RyuJIT Bug Advisory and Troubleshooting
RyuJIT.

As of October 2015, Microsoft have released the following updates that address these
issues with the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and
Windows 8 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.
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• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2
and Windows 8.1 - see: http://www.microfocus.com/docs/links.asp?
vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows
Server 2008 SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: 
http://www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available
through Windows Update) - see: http://www.microfocus.com/docs/links.asp?
vc=mskb3093266.

Note:

For applications created with earlier Micro Focus products or earlier versions of Enterprise Developer,
note the following:

Building
Applications

If, after upgrading to this version of Enterprise Developer, you start receiving
unexpected build errors when compiling an existing multi-project solution, this may
be a result of enabling parallel project builds in this release. These are a couple of
examples of issues that might be causing these errors:

• Using file references to project outputs in the same solution. You need to use
project-to-project references instead.

Use Project > Project Dependencies to manage the project dependencies and
build order within your solution.

• A customized build process such as one that is using pre- or post- build events.

If resolving any of these issues does not help resolve the build errors, consider
disabling the parallel build support - click Tools > Options > Projects and
Solutions > Build and Run and set maximum number of parallel project builds
to 1.

Note: Parallel builds are not supported with Mainframe Subsystem COBOL
projects.

Database
Access

Managed applications using SQL(DBMAN=ODBC) that were compiled in
Enterprise Developer 2.1 Update 1 must be recompiled in Enterprise Developer
2.3.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Enterprise Developer. For more
information, read the section Upgrading to Enterprise Developer for Visual Studio
2012 in the product Help.

Open PL/I
Compiler

Important: If you are installing this release as an upgrade to Enterprise
Developer 2.2 Update 1, after the upgrade you must rebuild any applications that
are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with –zp1, all parameters are treated as unaligned. (In
Enterprise Developer 2.2 Update 1, the behavior when compiling with –zp1 was to not
treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
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the –zp1 unaligned requirement was applied only to structure members and
parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the

parameter z element size (9 bytes) due to –zp1. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
–zp1, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in 
previous versions of Open-PL1 */ 

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

Note:

• To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.
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• For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

• On Windows 8 and Windows Server 2012, an issue with Microsoft Help Viewer 2.0 and Internet
Explorer's security being turned on can cause the Help content to be displayed as raw HTML
code. To resolve the issue, you need to turn off the Internet Explorer Enhanced Security
Configuration (IE ESC) for both administrators and users. Check the Microsoft Windows help for
more information on how to do this.

• To view the help in Visual Studio 2013, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

• For full details of the Visual Studio Help system, see the locally installed Microsoft Help Viewer 2.1
Help, which is available from Help menu in the IDE.

• To view the help in Visual Studio 2015, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

• For full details of the Visual Studio Help system, see the locally installed Microsoft Help Viewer 2.2
Help, which is available from Help menu in the IDE.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Installing Micro Focus Enterprise Developer Unix
Components

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing Micro Focus Enterprise Developer Unix Components
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.3_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.3_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).
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SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_2.3_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application is installed, you can silently install the license as follows:

• If you have access to the Internet and an authorization code, execute the following commands:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term activate AuthorizationCode

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term activate 
AuthorizationCode

• If you don't have access to the Internet but have a file from Micro Focus that contains the license string:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term install -f FileName

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term install -f FileName
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where FileName is the name of the text file that contains all the license strings to be used.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Enterprise Developer for Eclipse. When
you start the installation, if the 64-bit version of Java is already installed on your Linux machine, you might
not be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux
which prevent you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To
work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Enterprise Developer.

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

• To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat Enterprise Linux
(RHEL) 7.

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer available) required
a change in the MF SafeNet license installer for this platform and the way you can manually manage the
licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts automatically when
starting your machine. Only on RHEL 7, you must use the systemctl command available with the OS
if you need to override the default behaviour – for example, if you do not want run the MF SafeNet
licensing service at start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the following contents:

----------- start of /usr/lib/systemd/system/MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:
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reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the machine is booted.

enable Enables the SafeNet Service so it starts when the machine is booted.

For more information about systemctl, refer to the help available with the RHEL OS.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Installing Mainframe Access Server
Note: Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Introduction

The installation process for Mainframe Access Server (MFA) uses a single FTP operation to transfer all of
the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

• IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
• Two APPLIDs, two TCP/IP ports
• Availability of APF security authorization support personnel
• Access to a network share with acceptable space for source and data, as well as the ability to access

the IP address and ports used to access MFA
• The following installation-specific variable information:

Variable Description

drive
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Variable Description

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version of MFA creates new product run-time data sets before
the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be
used for fallback. If you prefer to retain your former production library names and re-use your
existing prodhlq, rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete post-
installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO                   <=== PDS (partitioned data set)
RECFM=FB                   <=== record format fixed and blocked
LRECL=80                   <=== 80 character record size
BLKSIZE=3120               <=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
                                3500 primary blocks
                                500 secondary blocks
                                50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a. Start FTP:

C:\>ftp your.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".

b. Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.
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c. Set file transfer type to binary:

ftp> binary
200 Representation type is Image

d. Set FTP prompting off to transfer all files without interruption:

ftp> prompt
Interactive mode Off.

e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.        
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.        

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB must be authorized.

If you are upgrading Mainframe Access from a version of Enterprise Developer prior to 2.3 you will need to
modify your production JCL procedures with reference to the supplied samples MFA, MFAS, and MFAAS.
The modification is necessary because at Enterprise Developer 2.3 Mainframe Access changed to being
built using the IBM XL/C compiler rather than the SAS/C compiler, so for each JCL procedure you need to
change the STEPLIB DD statement and add a new one, CEEOPTS.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect

MFAAS sample MFAAS application server started task

MFAVTAM sample MFA VTAM definitions
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PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task

SERVERS sample SERVERS configuration for MFA

UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
need to modify the MFAS started task JCL since the module names for Data Connect have been changed
to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall
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In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.3.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise
Developer help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
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3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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New Features in Enterprise Developer 2.3
This release provides enhancements in the following areas:

• Integration with Visual Studio 2015
• Integration with Visual Studio 2013
• General IDE enhancements - Visual Studio
• Building applications in Visual Studio
• COBOL editor in Visual Studio
• PL/I editor in Visual Studio
• CICS Web services (Technology Preview)
• Code analysis
• Code coverage
• Command line compilation and linkage
• Compiler directives
• Converting additional directives to project's properties
• Data File Structure command line utility
• Data File Tools (Technology Preview)
• Database access
• Enterprise Server for .NET
• Environment variables
• File handling
• iFileshare - Fileshare support under Enterprise Server (Technology Preview)
• Library routines
• Mainframe compatibility
• Managed COBOL syntax
• Micro Focus FTP utility
• Micro Focus Infocenter
• Micro Focus Rumba
• Microsoft Azure
• Micro Focus Unit Testing Framework
• PL/I support
• Preprocessors
• Profiler
• REST service interfaces
• Single file support
• Spooler housekeeping
• Transaction class (TRANCLASS) support
• Tunables
• Updated run-time system

Integration with Visual Studio 2015

Back to list

This release provides a new Enterprise Developer flavor that takes advantage of the new features of Visual
Studio 2015, including:
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Light Bulbs You can use the light bulb feature ( ) to quickly implement unimplemented
interfaces or to resolve unknown types.

Compatibility (Project
Round-Tripping)

Enterprise Developer supports the Visual Studio project round-tripping feature
which enables you to work with COBOL projects in Visual Studio 2012, Visual
Studio 2013 or in Visual Studio 2015 without the need to upgrade the project
file.

.NET Framework 4.6
Compatibility

Provides support for creating managed COBOL applications that target
version 4.6 of the .NET Framework.

Microsoft Help Viewer
2.2

Provides support for the Micro Focus Help in Microsoft Help Viewer 2.2.

Integration with Visual Studio 2013

Back to list

Enterprise Developer provides support for the new features of Visual Studio 2013 and the Visual Studio
2013 Integrated Shell, including:

Compatibility (Project
Round-Tripping)

Enterprise Developer supports the Visual Studio project round-tripping
feature which enables you to work with COBOL projects in Visual Studio
2010 SP1, Visual Studio 2012 or in Visual Studio 2013 without the need to
upgrade the project file.

.NET Framework 4.5.1
Compatibility

Provides support for creating managed COBOL applications that target
version 4.5.1 of the .NET Framework.

Scroll Bar Enterprise Developer supports the new and enhanced scroll bar in Visual
Studio 2013.

Visual Studio 2013
Themes

Enterprise Developer conforms to the new look and feel of Visual Studio
2013.

Microsoft Help Viewer 2.1 Provides support for the Micro Focus Help in Microsoft Help Viewer 2.1.

Note: The Visual Studio 2013 features CodeLens (Code Information Indicators) and Peek Definition
are not supported in COBOL.

General IDE enhancements - Visual Studio

Back to list

• Menu items - the following Micro Focus utilities were previously available under the Tools > Micro
Focus menu and have been moved as follows:

• ADO.NET Connection Editor - now accessed from View > Micro Focus SQL Tools.
• MFA Compare and Synchronization Monitor - now available directly under the Tools menu.
• MFA Server Access Configuration - now available directly under the Tools menu.
• OpenESQL Assistant - now accessed from View > Micro Focus SQL Tools.
• OpenESQL Configuration Utility - now accessed from View > Micro Focus SQL Tools.
• Web Service Client - now accessed by creating a new project of type "Web Service Client

Application from JSON/REST" - click File > New > Project > COBOL > Native > Web Service
Client Application from JSON/REST.

• Managed COBOL project properties - a new setting, Expose group linkage items to managed code,
is now available on the COBOL tab in the properties of managed COBOL projects. Checking this sets
the ILSMARTLINKAGE directive that specifies that group linkage items in your code are to be exposed
as properties of a class. A related button, Options, enables you to also specify whether to remove
specific prefixes from the names of COBOL data items, whether to make the new classes serializable,
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expose Linkage Section items as nested classes of the program class or to limit the property generation
to non-redefining elementary items.

• PL/I project properties - there is now a new page, Assembler, in the project properties of PL/I
Mainframe Subsystem Projects that enables you to set properties for configuring PL/I Assembler
applications.

• Resetting the file properties - a new button, Use Project Defaults, on the file property pages of COBOL
files in native projects now enables you to reset the file properties of COBOL files in native COBOL
projects.

Building applications

Back to list

Enterprise Developer now supports Visual Studio's parallel builds for COBOL projects. Parallel building
enables you to build multiple projects faster on multi-CPU machines. Following this change, in order for
your multi-project solutions to build in parallel successfully, ensure that the project dependencies and build
order are set correctly for your solution using Project > Project Dependencies. For more information
about parallel building, see Tips on Building COBOL in your product help and your product Release Notes.

Note: Parallel builds are not supported with Mainframe Subsystem COBOL projects.

See Related Information at the end of this topic.

COBOL editor

Back to list

The COBOL editor includes the following enhancements and new features:

• Improved Intellisense writing assistance for COBOL in both native and managed COBOL:

• Context sensitive suggestions - IntelliSense only shows suggestions that are relevant for the position
of the cursor in the code or for the type of project.

• Enhanced completion lists - lists include any relevant COBOL verbs, clauses and words, copybooks,
code templates, data items and section and paragraph names.

• Intelligent assistance with completing statements - when you have entered a COBOL verb,
IntelliSense shows suggestions for the relevant clauses and identifiers that you can use to complete
the statement.

• Automatic completion for single items - IntelliSense automatically inserts single suggestions in the
code.

• Qualifying non-unique names - IntelliSense qualifies data items whose names are not unique.
• Configuration preferences for IntelliSense - enable you to configure what suggestions appear in the

completion lists, whether suggestions are added in insert or overwrite mode, and the case of the
inserted words.

• Snippets - code snippets are now included in the IntelliSense suggestions.
• $IF-$ELSE-$END statement colorization - parts of a $IF Compiler-control statement that are not

executed are now colored in grey.
• $REGION statement - support is provided for the $REGION Compiler-control statement. You can use

$REGION - $END-REGION to surround blocks of code that you want to folded or expand in the editor.
• Copybook glyphs ( ) in the left-hand margin on a copy line - indicate that a copybook can be expanded

inline.
• Creating copybooks from selection of code - a new context menu command, Extract to Copybook in

the editor enables you to move a selection of COBOL code into a new copybook file. The file is added to
the project and the code in the original program is replaced with a COPY statement that refers the new
copybook.

• Expanded copybook view - provides indicators for read-only copybooks
• Outlining - outlining is now available on comment blocks, paragraphs and on $REGION and $IF

statements.
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• Task List comments - the COBOL editor now provides support for Visual Studio-style Task List
comments in COBOL. Typing TODO, HACK or UNDONE in the code immediately after the declaration
of the COBOL comment (*>, *>> or * in column 7) creates a task that appears in the Task List window.

PL/I editor

Back to list

The PL/I editor has the following enhancements:

• Support for opening include files from within the editor
• Comment and uncomment toolbar buttons
• Initial support for IntelliSense
• Red squiggles
• Margins

CICS Web services (Technology Preview)

Back to list

Enterprise Server has been extended to provide a CICS Web Services capability compatible with the
mainframe.

A new CICS Web Service wizard enables you to generate CICS Web service providers and requesters
using either a CICS COBOL application or a WSDL file as input. This enables you to develop and test,
including end-to-end testing, CICS Web Services for deployment to the mainframe.

Code analysis

Back to list

Enterprise Developer now offers more advanced code analysis features and enables you to run various
analysis queries (rules and groups of rules called rule sets) against your code to ensure adherence to
standards such as standards for coding or performance.

You can run analysis rules against programs in a project in the IDE at user request or you can run analysis
rules at the end of a project's build.

Code coverage

Back to list

Enterprise Developer now provides support for code coverage of native COBOL applications directly from
within the IDE where code coverage uses the Test Coverage functionality. You can produce code coverage
reports for applications running in the COBOL run-time and for applications that run in Enterprise Server.

To produce reports, you need to enable code coverage in a project's properties, compile your application
and then run your application with code coverage to produce the relevant reports. For applications that
require an Enterprise Server instance, you start the enterprise server with code coverage.

Command line compilation and linkage

Back to list

When using the cbllink command to compile and link, there is a new -y option. Use this option to create
an executable that includes support to be able to run on Windows XP and Windows Server 2003.

Compiler directives

Back to list

The following Compiler directives are new in this release:
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EOF-1A Treats a 0x1a character in the source file as the end of file.

NLS-CURRENCY-
LENGTH

Specifies the number of bytes to allocate for the currency symbol in a PIC field.

NULL-ESCAPE Treats a 0x00 character in the source file as an escape character for other non-
printable characters in the source code.

The following Compiler directives contain new parameters in this release:

DBSPACE The new parameter 'MIXED' extends the DBSPACE directive to be able to evaluate data
items in programs that contain a mix of single-byte and double-byte strings.

Converting additional directives to project's properties

Back to list

The Update Project Properties utility allows you to convert additional directives in your project to project
properties. This option is presented on opening a project. You can select to not show this dialog again by
unchecking Check Additional Directives for project properties in Tools > Options > Micro Focus >
General.

Data File Structure command line utility

Back to list

The Data File Structure Command Line (DFSTRCL) utility is a DOS-based command line utility that
enables you to create record layout (.str) files from COBOL debug information (.idy) files. You can use
the utility to process a single .idy file or batch process up to 100 .idy files.

Data File Tools (Technology Preview)

Back to list

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will be
delivered at a GA level and if it is, then the functionality provided might differ considerably from this
technology preview.

The Data File Tools (Technology Preview) is a new standalone text editor in which you can create and edit
data files. By nature of it being a 'technology preview' product, it does not currently include all the
functionality that was available in the previous version of Data File Tools - now referred to as Classic Data
File Tools. If you require any of the functionality not provided in this version, you can still use the classic
version by accessing it in the usual way.

To run Data File Tools (Technology Preview), type mfdatatools2 from Enterprise Developer's command
prompt or a terminal.

To use the new editor directly from the Visual Studio IDE, clear the Use classic data file tools check box,
available from Tools > Options > Micro Focus > Data File Tools. When cleared, the Data File Tools
(Technology Preview) version is used, when possible. When this editor does not support the action you are
attempting to complete, Classic Data File Tools is used instead. This check box is selected by default.

Database access

Back to list

This release provides the following enhancements to database access:

COBSQL This release provides:
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• Selection and configuration of the Oracle Pro*COBOL preprocessor for compiling
COBSQL applications in project properties on the SQL tab.

• Support for COBOL directives SOURCEFORMAT=TERMINAL and
SOURCEFORMAT=VARIABLE for Pro*COBOL applications.

HCO for DB2
LUW

This release provides:

• GUI versions of data migration tooling
• A new tool that enables you to bind or rebind all packages. See BindAll Packages Tool

for details.
• Support for MFHCO mode across all platforms by default via the new HCO (NOHCO)

DB2 compiler directive option. See the HCO DB2 compiler directive option topic for
details.

• A new DB2 compiler directive option, OPTPER (NOOPTPER), that enhances
performance for CHARSET EBCDIC processing. See the OPTPER DB2 compiler
directive option topic for details.

• A new DB2 directive option, BINDDIR, which specifies an alternative directory in which
to write the DBRM file created during compilation. See the BINDDIR DB2 compiler
directive option topic for details.

• 64-bit support for PL/I on appropriate platforms. See Additional Software Requirements
on Windows for details.

HCO for SQL
Server

This release provides:

• Support for the DATA-CHANGE-TABLE-REFERENCE clause.
• The following HCOSS Add-Ins have been converted to VSPackage Extensions:

• HCO for SQL Server Tools, now available under View > Micro Focus SQL Tools
• Options for HCO for SQL Server Tools, now available under Tools > Options >

Micro Focus
• Context Help is now provided for:

• Options for HCO for SQL Server tools
• Each tool in the HCO for SQL Server user interface

OpenESQL ADO.NET
Connection
Editor

In this release:

• The ADO.NET Connection Editor has been redesigned using a
series of Wizards that guide you through the processes of adding,
copying, and removing connections.

• Context Help is now provided for the main window, and each
Wizard page and dialog box.

Date/Time
Processing

This release provides streamlined datetime processing for ODBC and
ADO.NET.

Performance This release includes a new SQL compiler directive option, OPTPER
(NOOPTPER), that enhances performance for CHARSET EBCDIC
processing. See the OPTPER SQL compiler directive option topic for
details.

PL/I This version provides 64-bit support for PL/I on appropriate platforms.
See Additional Software Requirements on Windows for details.

PostgreSQL In this release, PostgreSQL 9.4 has been tested with OpenESQL and
OpenESQL Assistant using the following PostgreSQL software:
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Server software PostgreSQL EnterpriseDB version 9.4.4

Client software • psqlODBC driver version 09.03.04.00
• Npgsql ADO.NET 4.0 driver version 2.2.5

PostgreSQL 9.4 has been tested with OpenESQL and OpenESQL
Assistant on the following Windows platforms:

• Windows 32-bit
• Windows 64-bit

Note: Micro Focus provides compatibility for PostgreSQL but
does not directly contribute to or support the PostgreSQL
open source project. Any issues relating to PostgreSQL
functionality should be addressed through an open source
support vendor.

SQL Server This release provides support for the SQL Server OUTPUT clause.

Mainframe
Batch
Database
Tools
(MBDT)

This release includes mainframe batch utilities that provide the following functionality for
Oracle, DB2 LUW, and SQL Server agnostically, as well as specifically for HCO for SQL
Server:

• DSNTEP2
• DSNUTILB LOAD
• DSNUTILB UNLOAD
• 32-bit and 64-bit support
• New batch configuration utility

XA Switch
Modules

In this release, the XA interface has been redesigned to provide:

• Consistent look and feel for SQL Server, DB2, and Oracle user personalization
• Consistent look and feel for both RM dynamic and static registration (SQL Server, DB2,

Oracle, generic one-phase commit for ODBC)
• Additional support for two instances of the same switch module using CICS and Web

Services applications via the new XAID compiler directive
• Using a specified XA resource only with batch applications executing under Enterprise

Server

Enterprise Server for .NET

Back to list

This release provides enhancements in the following areas:

• CICS class library - the public API has been enhanced to contain types that can be used from
applications that are running specifically under the control of CICS. This enables you to call CICS
functions from within your CICS applications.

• IDE support:

• Integration with Micro Focus Rumba
• Support for submitting JCL files from within the IDE
• Character-set support
• Configuring the dynamic debugging setting from the IDE
• Starting a server when debugging starts
• Stopping running servers on when closing the solution or the IDE
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• Viewing the console log from within the IDE
• Creating or activating a listener if no listener is running
• Server Explorer view of the available servers
• Start, restart and stop commands for servers in Server Explorer
• Command for associating a server with your project

• Dynamic listener configuration - it is now possible to configure a listener both from the command line
tool and from within the Administration tool. Enables you to dynamically configure some aspects of a
listener's behavior such as to enable, disable, add or remove ports, or do disconnect sessions.

• EBCDIC support - CICS regions now support applications that use EBCDIC.
• EZASOKET - limited support is provided for EZASOKET to enable you to run applications that use

IBM's EZA functionality. Support is provided for the basic open, close, read and write statements and for
some control functionality for IBM's EZACICAL and EZASOKET APIs.

See the Enterprise Server for .NET product help for details about the supported functionality and the
current limitations.

• JES REST API - support is provided for JES control using the HTTP REST interface. This enables you
to use HTTP REST requests to perform JES functions. For example, you can use HTTP REST requests
to add initiators and printers, change a job class or to release jobs.

• Historical Statistics Facility (HFS) - when HSF is enabled for an Enterprise Server for .NET CICS
region, event records are created in the region database at run-time for transactions. These records can
be subsequently processed to provide detailed information of their execution. A GUI and a command
line tool are provided to analyze these statistics.

Note: HFS is available only in CICS regions. SQL API calls are not supported.

• Minidump support - you can now configure a region to automatically produce a minidump when an
exception occurs. This enables you to diagnose your system and trace any application faults.

• Importing and exporting resource definitions - you can now use the command line tool to export
resource definition information Enterprise Server for .NET into the Enterprise Server format. This
enables you to move your resource definitions between Enterprise Server for .NET and native
enterprise servers instances within Enterprise Server.

Environment variables

Back to list

The following new environment variables are available:

MFJ_REPRO_EMPTY Enables or disables the ability for the IDCAMS REPRO action to copy
from a pristine VSAM file. Permissible values: Y or N.

ES_JESYSMSG_RESTRICTED When system message spool files are being routed directly to the
Output queue, by using ES_JESYSMSG_OUTPUT, you can hold back
spool files based on their class, by using
ES_JESYSMSG_RESTRICTED. Permissible values: class names or
numbers entered as a continuous string; for example,
ES_JESYSMSG_RESTRICTED=ABC123.

File handling

Back to list

This release contains the following new configuration options:

ACUFH Enables or disables the use of the ACU file handler (ACUFH), which is required to handle
Vision and RM/COBOL indexed files.

ESACUFH Enables or disables the use of the ACU file handler (ACUFH) for file handling operations
running under Enterprise Server. ACUFH must also be enabled for this option to take effect.
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iFileshare - Fileshare support under Enterprise Server (Technology Preview)

Back to list

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will be
delivered at a GA level and if it is, then the functionality provided might differ considerably from this
technology preview.

Should you wish to test and provide feedback for this feature please contact Micro Focus Support Line
for instructions on how to enable the new functionality.

You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers. (Currently,
this type of configuration only supports having one stand-by server)

Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.

To reduce the complexity and to increase the stability of an iFileshare high availability group, it is
recommended that each region is configured as a dedicated iFileshare server. If other Enterprise Server
work is hosted within the group, the setup must be consistent on each server so that in the event of a fail-
over, the non-Fileshare work can be continued on the new primary server.

Library routines

Back to list

The following library routines are new in this release:

CBL_MANAGED_SESSION_GET_USERDATA Retrieves user data saved in the current RunUnit.

CBL_MANAGED_SESSION_SET_USERDATA Sets user data in the current RunUnit.

The following library routines contain new parameters in this release:

CBL_LOCATE_FILE You can now specify a file name that is a null-terminating string, which has resulted
in three new values available for the user-mode parameter.

Mainframe compatibility

Back to list

• IMS DBCS - Enterprise Server IMS support has been expanded to include applications that use double-
byte character sets (DBCS). MFS EATTR=ECGS (full DBCS string without SOSI) is now supported.

• Implement /DIS USER DEQUEUE - the /DEQUEUE USER command is now available to remove
messages from the message queue to provide you with greater flexibility when managing IMS systems.

• IMS message queue (available with the 2.3 HotFix1 update) - provides a new dynamic IMS message
queue that enables you to expand the queue on the fly, and also to fine-tune its performance
dynamically.

Managed COBOL syntax

Back to list

The following enhancements have been made to the managed COBOL syntax:

• The TYPE OF type-name[ANY...] syntax enables you to obtain the System.Type (.NET) or
java.lang.Class (JVM) object for a generic class, interface, or delegate.

• The self:: or super:: syntax is no longer required to access inherited data within a subclass.
• The ATTRIBUTE-ID syntax enables you to define new attribute types, which can be used in various

contexts.
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Micro Focus FTP utility

Back to list

A new utility, Micro Focus FTP (MFFTP), provides FTP support for JCL-enabled enterprise servers within
Micro Focus Enterprise Server. The MFFTP utility provides a support mechanism for batch processes that
takes advantage of FTP from JCL on the mainframe.

Support is available for:

• Fixed Block (FB) files
• Variable Block (VB) files
• Generation Data Group (GDG) files
• Configuring third party FTP clients
• Input and output temporary file handling
• Configuring the end-of-line markers
• Configuring the error codes
• Configuring the text messages

Micro Focus Infocenter

Back to list

The Micro Focus Infocenter Web site (http://documentation.microfocus.com) has been upgraded and now
includes the following improvements:

• Scope being persisted when you select a product documentation in the Product Documentation section
on the Micro Focus SupportLine Web site and choose to view the documentation in the Micro Focus
Infocenter.

• Updated Scope settings - provides the ability to nest four levels deep when setting a scope.
• Scope being persisted between browser sessions once it has been set.
• Creating automatic scopes using the Search Topics icon, .
• A link to change the scope from the search results when there are too many results.
• Improved Boolean search expressions.
• Details included with the search results.
• Help on how to use the Infocenter and how to construct search expressions - available using the

Infocenter Help button, .

Micro Focus Rumba

Back to list

Micro Focus Rumba version 9.4 is now supplied with the Enterprise Developer 2.3 setup file. The license
for Enterprise Developer will license all components of Rumba.

Micro Focus Unit Testing Framework

Back to list

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability, but it is not intended for production use and is not supported
as such. Furthermore, Micro Focus does not guarantee that this feature will be delivered at a GA level
and if it is, then the functionality provided might differ considerably from this technology preview.
During the preview, you are encouraged to share your feedback and experiences via the Micro Focus
community forum - http://community.microfocus.com/microfocus/).

The Micro Focus Unit Testing Framework is an xUnit style testing framework, available from the command
line, for procedural COBOL applications.

It includes much of the architecture you would expect in an xUnit framework. The test runner is a 32- or 64-
bit executable that you run from an Enterprise Developer command prompt. A test fixture or suite is a
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COBOL program compiled to .dll that can include the setup, the test case code, and the teardown
associated with the test case.

Test results are available in a number of formats. By default, results are displayed to screen and to a .txt
file, but you can use additional parameters on the command line to produce reports in JUnit format.

Microsoft Azure support

Back to list

Enterprise Developer support for Microsoft Azure has been updated to version 2.6 of the Microsoft Azure
SDK.

Support has been added to the product for making any future versions of the Microsoft Azure SDK
available before the next major release of Enterprise Developer. Micro Focus will deliver support for these
only upon customers' requests.

Note:

2.3 HotFix 1 update: This HotFix provides support for version 2.7 of the Microsoft Azure SDK in
Enterprise Developer for Visual Studio 2013 and 2015.

PL/I support

Back to list

This release provides the following enhancements to PL/I support in Enterprise Developer:

• 64-bit support - Enterprise Developer provides a full 64-bit environment for developing PL/I applications
on Windows, Solaris(SPARC), Red Hat Linux, and SUSE Linux to enable you to take advantage of any
64-bit features such as 64-bit address space or interact with 64-bit relational databases when
modernizing your applications.

• Data types - support has been added for GRAPHIC data type, including GRAPHIC, GRAPHIC
VARYING, GRAPHIC VARYING BIGENDIAN, Gx and G constants. This enables you use GRAPHIC
data within your applications to migrate to Open PL/I running under Enterprise Server.

• PL/I debugger:

• The cwgui debugger is no longer available. You can now use the cw_java debugger which provides a
richer graphical debugging experience.

• The debugger has been enhanced to support the evaluation of the following built-in functions:
CENTER, CENTERLEFT, CENTERRIGHT, HEX, LEFT, LOWERCASE, MAXLENGTH,
PACKAGENAME, RIGHT, REVERSE, ROUND, SEARCH, SEARCHR, TALLY, and UPPERCASE.

• New -systemmvs, -systemims, and -systemcics link options - the mfplx and linker logic has been
enhanced to decouple the -cics, -ims, and -mvs flags from the link options. If you have PL/I CICS EXCI
applications, this enables you to compile and link your applications more easily to run under the control
of JCL or IMS.

In addition, the macro preprocessor SYSTEM() built-in function will now correctly return the value of the
"SYSTEM" in effect (for example: IMS, CICS or MVS).

• The Open PL/I macro preprocessor now supports the following:

• The Open PL/I macro statement ANSWER. This enables the migration of PL/I code which uses
ANSWER in its PL/I macros.

• The use of arrays of FIXED and CHAR macro variables. This simplifies the migration and
maintenance of PL/I Macro preprocessor code that uses variable arrays.

• IBM Structure Alignment (-zalign) - the Open PL/I compiler has been enhanced to provide an option
which causes ALIGNED structures to map data elements at the same offsets as IBM's compiler. This
facilitates the migration of applications and data to Open PL/I running under the control of Enterprise
Server.
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Preprocessors

Back to list

Support has been added in the IDE for enabling and using multiple preprocessors with your projects.

A new page, Preprocessors, has been added to the project's and the files' properties of native COBOL
applications to enable you to choose one or more preprocessors to use when building your application and
to specify their order of execution.

New reporting capability is now available for user preprocessors: resp-main code 18 indicates that a buffer
contains a data name to be marked as modified by the immediately preceding preprocessed line. The data
name may be qualified and resp-more contains the column information for the reference.

Profiler

Back to list

Enterprise Developer now provides support for Profiler for native COBOL applications directly from within
the IDE. To produce reports, you need to:

1. Enable Profiler in the COBOL property page for a project.
2. Compile your application to apply the changes.
3. Run your application with Profiler to produce the relevant reports.

REST service interfaces

Back to list

RESTful service interfaces utilizing JSON as the media type in request and response messages are now
supported using the Interface Mapping Toolkit. This enables you to extend COBOL applications using
modern transport payloads and protocols.

Single file support

Back to list

The recommended way to work with files within Enterprise Developer is to include them in a project. For
situations where you might want to quickly open edit a single file, Enterprise Developer now provides
support for native COBOL files in the IDE when the file is not opened as part of a project. There is limited
support for the IDE editing, compiling and debugging features as full support requires a project file.

To enable full IDE support for single files, Enterprise Developer provides a path for creating projects from
them - right-click such files in the editor, and click Create COBOL Project.

Spooler housekeeping

Back to list

A new spooler housekeeping utility has been introduced (MVSSPLHK). It offers additional archiving
functionality compared to the previous spooler housekeeping utility (MVSP0027), and can also be
configured to run directly from a JCL job.

Transaction class (TRANCLASS) support

Back to list

Transaction class (TRANCLASS) support is no longer a technology preview feature, and is now a full
release feature.

Tunables

Back to list
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This release of Enterprise Developer contains the following updates to tunables:

default_cancel_mode A new parameter, and default, has been introduced for this tunable; see
default_cancel_mode for more information.

subsystem_cancel_mode A new parameter has been introduced for this tunable; see
subsystem_cancel_mode for more information.

Updated run-time system

Back to list

Enterprise Server has been updated to provide an execution environment capable of running applications
that were each built using different development products. A consequence of this is that If your application
has a main COBOL executable (.exe) that was built with a previous version of Enterprise Developer, you
should ensure that the executable is rebuilt and packaged with the new run-time system. This does not
affect mainframe subsystem projects deployed to Enterprise Developer. You can rebuild from the IDE or
the command line.

Other COBOL subprograms built with previous versions of Enterprise Developer are not required to be
rebuilt.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Debugging

Remote debugging does not work for programs running on AIX or HP machines, if you are trying to debug
using Enterprise Developer installed on a Linux machine.

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• Enterprise Server instances will fail to start if they have been configured with the MLDAP ESM module
to use external security and are started using Enterprise Server credentials that are not configured with
"user administration" privileges (that is they do not have an allow update ACE in the "User
Administration" security resource in the Enterprise Server Administration). A fix for this is available if you
install HotFix 1 of version 2.3. of this product.

IDE

• When searching in Visual Studio using the Find in Files command, if Look in scope is set to COBOL
Project Copybook Paths, you might get a message that no files can be found and the search might
erroneously return no results.

To work around this issue, add the copybook folders you want to search to the solution and then, in the
Find and Replace dialog box, specify Entire Solution in the Look in field.

-2835506 (1101288)

• When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.

• Replace All does not work inside the Expanded Copybook View
• For copybooks with file extensions that are not traditionally associated with COBOL you must first add

the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

ICETOOL Emulation

ICETOOL emulation for managed code is not available in this release.

Linking

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C object
code built with that version of Visual Studio in the same executable. In this scenario, you must use the
Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro Focus
cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might also need to
specify some additional C runtime libraries - see the Microsoft documentation for more details.
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Note that when using COBOL and C object code together, Micro Focus recommends you build and keep
the COBOL and C executables separate, and use import libraries and the Micro Focus C functions for
calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between them.

Micro Focus Rumba

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference to
localhost or your host machine's name.

PL/I Support

• The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

• On SUSE, the PL/I CodeWatch debugger does not display output with MicroFocus ViewNowX. To
resolve this issue, you need to install a HotFix of ViewNowX - contact Micro Focus SupportLine for more
details.

• Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need to
undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying using
the WebLogic GUI, you can use the command line. If there are issues with this as well, try reducing the
length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise server
might fail due to the same-origin policy (SOP). Some browsers might implement (or support plugins that
implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that enable
sending cross-origin requests successfully. For REST services, Enterprise Server does not implement a
method for relaxing SOP. This means that browsers that implement CORS (or any other SOP relaxation
technique) might still forbid requests made from scripts due to Enterprise Server not implementing the
equivalent technique on the server side.

Setup

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that version
of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10 before you start
the installation of Enterprise Developer for Visual Studio 2013.

• Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has
a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Enterprise Developer for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• MTO - JCL ESMAC
• MTO - JCL MVS
• MTO - JCL System Catalog
• MTO - JCL Utils - IDCAMS
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I RTS
• SQL: COBSQL

.NET Compiler

Back to the list

• In member reference in managed COBOL syntax, you may now only use parentheses when referencing
methods. You can no longer specify parentheses when referencing fields or properties, as this will
produce a syntax error. For example:

set intLength to testString::Length()

must change to:

set intLength to testString::Length

MTO - JCL ESMAC

Back to the list

• As part of an enhancement to improve performance of the spool display function, several new indices
have been added to the casspool.dat file. If you are upgrading from a previous release, you must
convert the casspool.dat file of any enterprise server created before Enterprise Developer 2.2
Update 1 to the new format before starting any JES-enabled enterprise server and submitting jobs to it.

This release provides the following scripts that convert the casspool.dat file to the new format:

• On Windows: fixcasspool.bat in %COBDIR%\bin or %COBDIR%\bin64
• On UNIX/Linux: fixcasspool.sh in $COBDIR\bin

,

To convert the casspool.dat file, run the appropriate script from an Enterprise command prompt
using the following syntax:

• On Windows:

fixcasspool.bat <old-location>casspool.dat <new-location><backup_filename>

• On UNIX/Linux:

fixcasspool.sh <old-location>casspool.dat <new-location><backup_filename>

Where:
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• <old-location> - the fully or partially qualified location of the existing casspool.dat file, if not in the
current directory. Optional.

• casspool.dat - the spool file that will be updated. The file is located in the same directory as the
enterprise server's system catalog.

• new-location - the fully or partially qualified location where the backup file will be created, if not in the
current directory. Optional.

• backup_filename - the name of the file that will be a back-up of the old casspool.dat file. If the file
name already exists, the script terminates without converting the casspool.dat file.

If you do not convert casspool.dat, attempts to start the enterprise server fail with the following
messages:

JES000011E Batch Spool File Error; Status [39]  
          JES000130E Note JES000011 Error - New casspool indexes may need 
generating. See error 
          description in product docs  
      

2654417 (1090421)

MTO - JCL MVS

Back to the list

• The final disposition processing of temporary datasets has been corrected to be in line with the
mainframe processing, with a default value of PASS unless DELETE has been specified in the DD card.
Previously, the default value was DELETE.

2671175 (1091627)
• When running batch programs, receiving an "Out of Space" error requires operator intervention to

continue processing.

2642115 (1089055)

MTO - JCL System Catalog

Back to the list

• You can now use MGMTCLAS to provide an EXPIRE AFTER number of days. This is used to calculate
an expiry date for datasets allocated using the MGMTCLAS parameter.

2664639 (1090992)
• MFLEX*.DAT files were not being moved with spool files. Spool housekeeping now deletes LEX files

when it deletes JESYSMSG. Also, to identify any remaining orphan LEX files, the
MF_SPOOL_HK_LEX_SCAN environment variable sets spool housekeeping to scan the data directory
for LEX files older than the max retain period.

2659555 (1090759)
• Spool housekeeping has been rewritten to provide a number of new features. These will be described in

the product documentation.

(592452)

MTO - JCL Utils - IDCAMS

Back to the list

• The state of VSAM virgin files is now being correctly processed.

2686149 (1093587)
• A REPRO COUNT of zero is now processed as zero records to be included in the REPRO operation.

2665006 (1091034)
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Open PL/I Compiler

Back to the list

• On Intel platforms, the -bitsltr Compiler option can be used to store bit strings left-to-right within each
byte. This is similar to Big Endian bit ordering on Intel platforms. The Intel default is to store bit strings
right-to-left within each byte similar to the Intel hardware bit ordering.

2675860 (1092098)
• The libraries libmf.so, libespli.so and libespliz.so are no longer delivered. This is

transparent if linking PL/I objects using mfplx or ldpli, and no changes are needed to your build process.

However, if linking PL/I objects using either the UNIX ld command or the Enterprise Developer cob
command, you must include the libraries libmfpli.so when linking stand-alone Open PL/I objects
(executed outside of Enterprise Server), or libmfpliz.so when linking PL/I objects executed under
the control of Enterprise Server.

To do this, use the option -lmfpli for stand-alone Open PL/I objects or -lmfpliz, respectively, for PL/I
executed under Enterprise Server. These options replace the –lmf option.

• Open PL/I applications must be recompiled and re-linked in order to use them with this release.

Open PL/I Debugger

Back to the list

• The debugger now stops before an ON UNIT triggers. This lets you perform debugging on the ON UNIT
itself. You can configure the ON UNITS the debugger stops on.

2674783 (1092319)

Open PL/I RTS

Back to the list

• Writing to SYSPRINT when running outside of Enterprise Server now drives output directly to the
terminal and does not buffer the I/O.

2477031 (1076203)

SQL: COBSQL

Back to the list

• COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• CASRDO
• CICS Support
• Code Analysis
• Compiler
• Data Tools
• Debugging
• Designer
• Documentation
• ecijava
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• HCO for Microsoft SQL Server
• IBM Language Environment for OS/390 and VM Support
• IDE
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Library
• Mainframe Access
• Micro Focus Common Client
• Micro Focus Communications Server
• Micro Focus Directory Server
• Micro Focus Server Administrator (GUI)
• MLDAP API Interface
• Monitoring and Management
• PL/I Support
• RM COBOL
• Run-Time System
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• SQL Option for DB2
• XML Extensions
• XML Support

Adis

Back to the list

• Paste now works as expected when pasting into numeric items under MS(2) with ACCEPT statements.

2800091 (1096820)
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• When the MS Compiler directive is set, ACCEPT with EMPTY-CHECK now supports manually entering
of a zero for numeric items and a space for alphanumeric items.

2795831 (1096324)
• When using ACCEPT WITH UPDATE with the MS Compiler directive, the pre- and post- display

behavior is now the same as that of the MS compiler.

2795709 (1096311)

CASRDO

Back to the list

• When trying to access the Catalog page from casrdo45, the JESSPOOL class was checked instead of
DATASET.

2819633 (1099350)
• The ESMAC Spool view is now sorted correctly when using a filter criteria.

2798643 (1096681)

CICS Support

Back to the list

• Compiling a BMS file that includes COPY statements and macros that contain comments no longer
shows an error in scenarios where the /PREPASM compiler directive is used to pre-process the BMS
file and no pre-processing errors were reported.

2791709 (1095975)

• Previously, if an EXEC CICS RECEIVE MAP was executed in a transaction that was started from an
EXEC CICS START TERMID, the RECEIVE would hang.

2811686 (1098238)
• TWA registrations no longer cause memory leaks.

2808391 (1097845)
• It is now possible to use an environment variable to configure the maximum number of pool threads of

threaded processes. This should only be used if requested by a Micro Focus SupportLine
representative.

2808391 (1097846)

• The CICS Web interface now supports http requests that are greater than 32k. Previously, a LINK to the
application would fail with errors EIBRESP 22 (LENGERR) or EIBRESP2 11 (The COMMAREA length
is less than 0 or greater than the permitted length). Note that a request in the commarea will be
truncated as is the behavior on the mainframe.

2833996 (1101078)
• Previously, an EXEC CICS INQUIRE TASK LIST statement with more than one option (RUNNING/

SUSPENDED/DISPATCHABLE) would return the information about the current task only, even if there
were other running or suspended tasks in the system.

2819519 (1099396)
• Executing the first EXEC CICS READ statement on a file defined as a remote one on the TOR and both

as a cataloged one and "open on first reference" on the FOR no longer fails.

2809423 (1097915)
• This release provides a new user exit, casmguex. You can use casmguex to control whether a particular

message is displayed on the console or not.

2808523 (1098090)
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• The EXEC CICS FORMATTIME option MILLISECONDS is now supported. MILLISECONDS(data-area)
returns the number of milliseconds in the current second specified by ABSTIME as a binary integer in
the range 0 - 999.

2807604 (1097661)
• When a SIT commarea override is set, an XCTL with a commarea now passes the data correctly.

2804601 (1097349)
• The Micro Focus implementation of ECI was matching a shorter system-name than the one specified. Is

is now verifying the name on length of the server name passed to the ECI interface.

2800359 (1096885)
• When using COMMAREA override, the exit of an XCTL command was not restoring the ptr for the next

COMMAREA to the original COMMAREA.

2793862 (1096334)

• When changing a class in ESMAC for a sysout, the MVSSPOOL class was not changed to reflect the
new class, and the old class was being passed to the exit. This has now been fixed.

2680710 (1092574)
• To ensure that the F1 Help function behaves correctly, the resource definition file must be upgraded

using the command: caspcupg /dp=<resource-definition-path>

2789687 (1096765)

Code Analysis

Back to the list

• An issue that was causing a slow down in opening source files in the editor has been resolved.

2804209 (1097351)
• Sequential line calculation has been fixed to provide correct position of POI (Point Of Interest) within file.
• The analysis component no longer hangs when running on programs containing DBCS (double-byte

character sets).
• 'error starting the query' and other similar non-descriptive error messages have been expanded to

include additional information as to what caused the error.
• The generic "Violations detected" string, preceding the actual description for the rule, has been

removed from the rule description. Users of Enterprise Developer for Visual Studio will no longer see
this string as part of the description.

Compiler

Back to the list

• A program compiled with the INIT-BY-TYPE directive that contains 'PROGRAM-ID IS INITIAL' syntax
and declarations of index names or data items now produces correct intermediate code.

2831469 (1100741)
• A redefinition of a CICS-inserted DFHCOMMAREA block that is preceded by a level 77 definition now

compiles correctly.

2831205 (1100706)
• Programs compiled with DIALECT"RM" and containing 'PROGRAM-ID .. AS' syntax now execute as

expected.

2830956 (1100700)
• The CP preprocessor used in conjunction with the COBSQL preprocessor now correctly replaces any

text affected by the COPY... REPLACING statement.

2826558 (1100370)
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• When using the WINDOW1 preprocessor, specification of the AUTOCLOSE option no longer prevents
subsequent preprocessor options from being actioned.

2822206 (1099687)
• The output from the SETTINGS compiler directive now also appears for programs specified via the

ILSOURCE option.

2822102 (1099604)
• The XML GENERATE statement now functions as expected in programs containing the DECIMAL

POINT IS COMMA clause.

2821786 (1099599)
• The XML GENERATE statement now executes correctly when the specified FROM operand is a group

containing nested ODO tables (which is only possible with the ODOSLIDE directive).

2821779 (1099600)
• The INITBYTYPE compiler directive no longer causes spurious flag messages with DIALECT(OSVS).

2820920 (1099488)
• The LINE-COUNT Compiler directive now operates as expected.

2817442 (1098979)
• The maximum size of data items in a program compiled with the DIALECT(ENTCOBOL) directive now

correctly reflects the respective mainframe values in the latest version of Enterprise COBOL.

2816030 (1098926)
• The Compiler now rejects the use of special register names as arguments for reserved word altering

directives. You can only specify standard reserved words with these directives.

2813931 (1098542)
• Data names that start with a numeric digit and contain DBCS characters are now accepted by the

Compiler, as expected.

2813223 (1098456)
• A MOVE operation of an alphanumeric literal to an unsigned numeric DISPLAY field under RM/COBOL

emulation now executes as expected.

2812561 (1098446)
• Data names longer than 30 characters are now flagged when specifying the FLAG option with a

mainframe argument and not just when using the equivalent full DIALECT.

2810924 (1098133)
• Compiling a program with the COBSQL preprocessor, which contains a COPY REPLACING statement

with trailing spaces in the replacement pseudo text, now works as expected.

2807470 (1097737)
• Compilation of a program containing a GO TO statement that references an undeclared procedure

name, and has the RESTRICT-GOTO directive set no longer results in a run-time exception.

2807280 (1097616)
• A user function that specifies a PIC 1 item as a RETURNING field now receives an appropriate compile-

time error.

2806037 (1097470)
• The addressability of a linkage data item is now checked correctly.

2805523 (1097453)
• Compilation with a mainframe dialect, of a program containing a CALL statement with a mixture of

non-01 level group items and literals, now proceeds as expected with no internal error produced.

2803613 (1097190)
• A debugger query of a condition name with a negative literal VALUE now returns the expected result.

2801993 (1097607)
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• The combination of a mainframe dialect and SOURCEFORMAT(FREE) no longer produces unexpected
compiler errors referring to tokens being in the wrong area of source.

2800332 (1096911)
• The specification of an alphanumeric literal in the VALUE clause of a DBCS data item (i.e. the G\N

prefix is missing) is now accepted as an MF extension. This still generates an error under mainframe
dialects, but can be hidden/suppressed like any other flag message.

2798426 (1096574)
• Under DIALECT"MF", the Report Group description entry now permits the NEXT GROUP NEXT PAGE

clause without a LINE clause.

2798367 (1097201)
• It is now possible to specify fixed-point numeric literals without a trailing separator space before the next

token or operator. This provides a better mainframe emulation.

2797274 (1096469)
• A new CP option, ANYCOPYCASE, now provides more flexibility in matching the case of copybook

names.

2797035 (1096494)
• Previously, numeric items that used a decimal point and the OR sign were truncated when using the MS

display syntax under MS(2).

2795709 (1096308)
• DBSPACE(MIXED) directive has been implemented to allow comparison of mixed single and double-

byte spaces to the SPACE figurative constant.

2679222 (1092427)
• When importing an Enterprise Developer source file, the generation of a CBLast (COBOL Abstract

Symbol Table) file no longer hangs when instructed to process a COBOL.DIR file.
• Mixing alphanumeric and national items in intrinsic functions which only allow one type now produces a

syntax error.
• A source line longer than the maximum supported by the compiler no longer receives an error about

truncation if the line is simply a comment.
• An error during compilation, when creating .int files when the COBDATA directive is set, has been fixed.

• A bug in accepting a field containing double-byte and single-byte characters has been fixed.

2829369 (1100513)
• A bug during compilation has been fixed, which caused a Run-Time System error 114 when generating

32-bit programs using the OPT directive, containing decimal operations.

2819838 (1099305)
• An error has been fixed in COMPUTE statements of the following form: COMPUTE a = b / constant

where a and b are COMP-3 or DISPLAY; a has greater than 19 digits and b has less than or equal to 19
digits, and constant is a literal which is a power of 10 (such as 10, 100, 1000, etc.)

2808008 (1097715)

• Very large screen section records no longer produce unpredictable errors when generating managed
COBOL code.

2830002 (1100580)
• Programs that contain report-writer syntax, and are compiled with either PERFORMTYPE(RM) or

PERFORMTYPE(OSVS), now behave as expected.

2824931 (1099963)
• When forming externalised names for ILSMARTLINKAGE, any double-byte hyphen (or similar)

characters are now removed from the name.

2822491 (1099668)
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• For class programs containing COBOL files declared in the OBJECT section, it is now possible to
explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2819597 (1099273)
• The use of the SCREEN SECTION CONTROL phrase in .NET unverifiable code no longer causes the

generation of illegal code.

2818736 (1099170)
• An INITIALIZE statement applied to a file record, which is not otherwise referenced, now correctly

initializes the whole record area.

2817756 (1099017)
• Verification or run time errors are no longer produced when NUMPROC(ACOS) is specified, and a level

88 item is declared for a numeric item in the Linkage section of your program.

2815137 (1098693)
• Opening a XAML file in a WCF client project no longer causes an unhandled exception to be generated.

2813004 (1098525)
• You can now use an external member reference as a target operand for the INITIALIZE statement. In

previous versions of the product, you could not.

2812151 (1098318)
• In previous versions of the product, compilation errors resulted when the NOILNATIVE directive was

specified when compiling programs that used the OCCURS ANY syntax for defining tables. This is no
longer the case, and the NOILNATIVE directive has no effect on such tables.

2809432 (1097893)
• The INITIALIZE statement is now working as expected when applied to a group item where an

OCCURS subgroup follows a FILLER data item. Previously, this could produce bad code, initializing
incorrect areas of the group.

2805149 (1097372)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2802641 (1099053)
• When compiling for managed code (.NET or JVM), a zero length literal used as a value for a PIC N data

item no longer crashes compilation with run-time error 181.

2799176 (1096677)
• If a method has an optional parameter with a default value of System.Reflection.Missing.Value, and that

parameter was omitted in a method invocation expression, that parameter was being passed as null,
instead of the correct default value. This affected a number of methods - for example,
Microsoft.Office.Interop.Excel.

2796911 (1096408)
• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)
• Managed code that includes operands of the form 'typedef-name AT pointer' now generates correctly.

(607855)

Data Tools

Back to the list

• It is now possible to associate data files with specific .STR files. This information is stored in the .pro file
for the respective data file.

2792214 (1095979)
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• Creating a record or a segment layout file no longer fails when the COBOL names contain double-byte
characters.

(606488)

Debugging

Back to the list

• Pointer values no longer get incorrectly byte-swapped when their value is accepted.

2824427 (1100287)
• Trying to view the values of data-items that contain UTF-8 data no longer corrupts the values.

2810079 (1097992)

• You can now enable debugging of CGI programs when invoking them multiple times. To do this, check
"Return to waiting state when debugging" on the Debug tab of your project's properties.

2794496 (1096442)

Designer

Back to the list

• When importing using the Designer, you now receive an "Source Code Import Wizard Detected Errors
Page" if there are parsing errors. See your product help for more details. Previously, the import process
proceeded even when there were parsing errors. If errors or warnings were reported but the FD and 01
extraction process ran to completion, the errors will be reported but the "Next" button is enabled to allow
the partially extracted data items to be imported. The "Back" button is also enabled allowing the process
to be repeated once the errors are fixed. If a severe parsing error occurred, the errors are reported and,
since they must be fixed, the "Next" button is not enabled.

Documentation

Back to the list

• The product help now includes the optional attributes for the ‘container’ objectclass definition used by
Enterprise Server external security.

2801420 (1096977)
• The product help now includes information about how to retrieve the Run-Time System error code from

a file status code returned as a decimal value. For example, if you receive 14657 as a value for the file
status, this is a decimal value. This converts to 3941 HEX. The second byte of this value, 41, must be
converted to Decimal before looking at the RTS error code - thus this HEX value then represents an
extended file status code of 9/065 which means the error code is COBRT065, a locked file status.

2822853 (1099769)
• The MFJSTATS topic has been updated to clarify that this refers to a COBOL SORT operation.

2828881 (1100446)
• The Micro Focus Infocenter documentation for Enterprise Developer for Visual Studio has been updated

with the correct instructions to launch the Net Express Project Import wizard.

2802047 (1097052)
• The product documentation about the START statement and Relation Conditions now states that THEN

may be used instead of THAN.

2799291 (1096903)
• The topic "Using the CP Preprocessor to Expand Copybooks" in the product documentation has been

updated to include the following text: If the MODE=ANSI option is specified to the Oracle precompiler,
Pro*COBOL, then you should additionally use CP's SY directive to ensure that the SQLCA gets
populated correctly.
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2792368 (1096084)
• The default setting for the ES_ESM_PLTPISEC variable is NONE.

2821810 (1099672)
• Additional information has been added to the description of the CASSI1400 error message.

2821806 (1099711)
• The AdminAPI resource class has been documented for ESF features.

2815870 (1098815)
• The Enterprise Server documentation for Retain Periods has been updated to include additional

information specific to spool output.

2790146 (1095777)
• The LISTCAT topic in the documentation has been updated to reflect accurate column headings and

descriptions for output format.

2789939 (1095765)
• Topic amended to refer to entry_point_mapper rather than entry_name_mapper.

2807744 (1097673)
• Details on MF_MVSJOB environment variable added.

2797526 (1096488)
• The documentation for Visual COBOL and Enterprise Developer 2.2 Update 2 for Visual Studio 2010 on

the Micro Focus Infocenter now correctly lists Microsoft's Visual Studio Service Pack 1 as a prerequisite.
The installation instructions also provide instructions about how to install the product if your machine is
not connected to the Internet.

2803705 (1097455)
• The Micro Focus Communications Server now supports rotational log files. To enable this feature, you

need to edit the mf-server.dat file, which resides in the product's bin directory (Windows), or the
$COBDIR/etc directory (UNIX). The mf-server.dat file contains details of this feature under the [logging]
paragraph, and full documentation is provided in the online help under "Server Instance Diagnostics:
CS Console".

2675327 (1092083)
• NONCONNECTED has been added to the list of attributes of DECLARE.

ecijava

Back to the list

• Stateless Java ECI requests no longer cause memory leaks in MFCS as a result of abandoned
sessions.

2822108 (1099645)
• The Enterprise Developer product help now includes information about the CICS Resource Adapters

and ECI.

2799936 (1096775)

Enterprise Server

Back to the list

• When using an EXCI link and a PPT defined with commarea 32767, the modified commarea was not
reflected back to the caller.

2830739 (1100654)
• It is possible to configure a Visual Studio or an Eclipse project to perform emergency debugging of an

application running in an enterprise server even when the server is operating in production mode (with
dynamic debugging disabled). To prevent this, starting with this HotFix, you can use the environment
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variable ES_PRODUCTION in the server’s [ES-Environment]. When set to Y, this variable prevents the
IDE from initiating a debug session.

2825848 (1100160)
• When running with HSF switched on, it was possible to have a concurrent shared memory access

which would lead to shared memory corruption. This would most likely occur when running JCL jobs
although it could occur with any tasks. Shared memory access in this scenario is now performed under
a shared memory lock.

2824909 (1099975)
• When using a secure region and when the environment variable

ES_ESM_DISABLE_DFLTUSER_ESMAC is set to Y, clicking on the Home button in the signon page
now correctly opens the MFDS page.

2824772 (1099949)
• When the casspool.dat file is shared across multiple servers (excluding cluster scenarios), ESMAC

displays all jobs, including those that are not running in the current server. However, it is only possible to
cancel jobs that are running in the current server. For other jobs the CANCEL button is disabled.

2824230 (1099917)
• It is now possible to start a BATCH printer in ESMAC if its name consists of space characters only but

an exit name is provided.

2819122 (1099216)
• When using ESMAC, Enterprise Server now correctly loads the MFESMAC resource class, when

necessary. Previously, it was loading the ESMAC class.

2814789 (1098652)
• You can now use the environment variable ES_ESM_DISABLE_DFLTUSER_ESMAC in order to disable

the ESMAC default user. When this variable is set, the "DEFAULT" button on the logon screen is
disabled and a valid userid and password must always be entered.

2813092 (1098438)
• DBCS fields are now processed correctly when the PS attribute is set in the DSECT rather that defined

in the MAP in single field, groups and OCCURs.

2811683 (1098233)
• Web service timeout values are no longer truncated to two digits.

2792860 (1096024)
• An issue with dynamic debugging has been fixed where, previously, the ports that were freed were not

being reallocated.

2785911 (1095510)
• An artificial restriction on the size of cookies passed when invoking ESMAC requests has been

removed. Previously, this was causing Run-Time exceptions.

2692460 (1094557)
• The characteristics of an FCT that references a cataloged file are now refreshed on each file open.
• If a file was already present, the date for an open request was not sent to the file handler.
• Open and close operations are no longer recorded in the transaction logs and replicated by extension

when they are associated with open input requests.
• A secondary node in a group no longer attempts to take over the role of a primary node. The entire

group now initializes correctly and all roles are assigned as expected.
• Microsoft's Internet Explorer versions 10 and 11, by default, does not use the current form name. As a

result, when invoking the javascript functions, the form name was not correct and the product behavior
was wrong. This has now been fixed.

• This release provides a number of enhancements to the CAS administration console:

• Improvements have been made to the log-in mechanism for situations where you are using an
External Security Manager to secure the MFDS and Enterprise Server, and you are logged on to
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MFDS and ESMAC using different user accounts – for example, "user1" and "user2", respectively. If
you navigate from ESMAC to MFDS and you log off "user1" from the MFDS, this will now
automatically log off "user2" from ESMAC as well.

• When using an external security manager, if you sign off from ESMAC, the sign on screen no longer
preserves and displays the userID of the last user that was logged on.

• An issue with the "Home" link in the ESMAC sign on page when the environment variable
ES_ESM_DISABLE_DFLTUSER_ESMAC is set has been resolved.

2814494 (1098607)

• A memory leak occurred in the External Security Facility's MLDAP ESM Module in some HotFix
releases of Enterprise Server 2.2 Update 2.

2833758 (1101024)
• When using the Enterprise Server External Security Facility with the audit feature, some audit events

generated by ESF Admin requests (such as ADDGROUP or ALTGROUP commands specifying many
group members) may include too much information to fit in a single audit event. These parameters are
now split across multiple audit events of category 5, type 3. Each split parameter has a unique number
(per process), and each piece of a split parameter has a sequence number. The original event will
contain a string with the split parameter identifier.

2827010 (1100238)
• The new resource access authorization processing in Enterprise Server's MLDAP ESM Module (LDAP-

based security), introduced in HotFix releases of Enterprise Server 2.2 Update 2, now correctly handles
cases where multiple access control entries have the same rank. For example, this may apply when all
group mode is enabled and an Access Control List (ACL) contains Access Control Entries (ACE) for
different groups the user belongs to.

2826650 (1100313)
• In Enterprise Server 2.2 Update 2 HotFix 06 only, when Enterprise Server External Security is used

with the "Version 2 Authentication" mode enabled, some ACEs might not be processed or applied. This
has been fixed.

2826650 (1100195)
• When using the Enterprise Server External Security Facility (ESF) with auditing enabled, and using the

ESF Admin API (programmatically or with the Enterprise Server Administration web interface or the
esfadmin command-line tool) to make certain changes to security data, very large audit events could be
generated. In some circumstances these could cause the Audit Manager process to crash or hang the
program making the request. This has been corrected by truncating parameter information for very large
security administration requests.

2825505 (1100158)
• When using Enterprise Server External Security Facility (ESF) with the optional Referential Integrity

User Exit, integrity constraints are now ignored for Access Control List (ACL) actors containing wildcard
characters. This enables ESF Admin actions that include resource access control ACLs containing
wildcard actors.

2824117 (1099908)
• The optional ESF Referential Integrity user exit module no longer fails with an LDAP "filter error"

message when processing certain resource-rule commands, such as ALTRESOURCE, for resource
rules with names that include an asterisk, "*".

2824049 (1099884)
• The "referential integrity" sample user exit module for Enterprise Server External Security no longer

causes the MFDS process (Enterprise Server Administration) to terminate when external security with
the exit is configured for MFDS, and MFDS is used to add a user or to perform some other security
administration tasks.

2823947 (1099880)
• A new MFDS command line startup option (-b) is now available. Specifying -b disables the

establishment of anonymous MLDAP API sessions.
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2818587 (1099264)
• This release enables you to prevent an Enterprise Server Monitor and Control (ESMAC) user from

displaying an enterprise server's environment variable settings using the "Env. Vars." button or the direct
URL. To enable this feature, you need to create a new element (ENV*) in the LDAP schema in the
CN=MFESMAC group below CN=Enterprise Server Resources.

This release includes an updated copy of the supplied LDIF import files that contain this change. Once
this element is installed in the security manager, you can control the visibility of the environment
variables page by configuring the group/user access rights using the microfocus-MFDS-Resource-ACE
attribute.

2811696 (1098264)
• The number of security manager user group members displayed by the Enterprise Server

Administration and the esfadmin tool is no longer limited to a maximum of 1024.

2807579 (1097703)
• Trying to use the SNMP audit emitter with Enterprise Server no longer fails with a run-time system error

114.

2800729 (1096951)
• The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports

"nested" user groups where one user group can contain another user group. Members of the contained
group belong to both groups. This enables administrators to define very large user groups as well as
hierarchies of user groups.

2510993 (1078988)
• A new option, "LITERAL=YES" has been provided in the Enterprise Server External Security Facility's

Administration API, and in the esfadmin command-line utility. When this is set, "*" is not interpreted as a
wildcard when using any of the administrator's LIST commands. This is particularly useful for listing
resource access rules that include "*" in their name. Search the product documentation for esfadmin for
more information.

• Oracle and OCI XA switch modules leaked memory when using user personalization.

2830922 (1100676)

• When issuing an ENQ change request in a cluster environment, the request to change the lock type
was being sent to the GLM but not processed locally. It is now also being processed locally.

2826218 (1100148)
• During a cluster RECONNECT request, each cluster client sends a list of active locks and the GLM re-

populates the Global ENQ. Since the introduction of the VSAM shared options, the lock may also
contain a tca ptr which is used to store the client's casmgr information. This is required for lock with
persistence server. A pointer set to low-value was sent as part of a GIVELOCK request, but on the GLM
that value was not used. This causes a run-time system error 114 in casgreqt on the RECONNECT/
GIVELOCKS function. This fix allocates the required tca for client casmgr for a RECONNECT request,
sets up the pointer depending on the lock persistence type as well as the clients casmgr PID.

Enterprise Server for .NET

Back to the list

• Under Enterprise Server for .NET, it was possible for requests that were associated with a terminal and
marked active, but not yet associated with a SEP, to not to be removed when the terminal disconnected.
This resulted in the number of SEPs available to run transactions in the system being reduced.

2795346 (1096261)
• Enterprise Server for .NET now supports SNA Character Stream (LU1) printer devices using the

TN3270E protocol.

2795343 (1096260)
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• You can now configure the Enterprise Server for .NET MMC UI to make regions defined by one user
visible to all other users on the same machine.

2638194 (1088649)
• The Enterprise Server for .NET MMC UI crashed when clicking OK on the "Select Connection String"

dialog box and a connection string had not been selected.
• In Enterprise Server for .NET, a NullReferenceException occurred when either putting null data into, or

getting null data from, a CHAR container specifying a CCSID different to the container's default.
• Sometimes, when trying to open a file with the CICS Resource Definition or Region Startup file editor in

Enterprise Server for .NET, you could receive an exception and the UI would crash.
• HTTP requests to Enterprise Server for .NET now consistently clean up their own sessions at

completion.
• You can now specify self-hosted WCF configuration in the Enterprise Server for .NET web.config file.
• Enterprise Server for .NET now enables you to configure regions to generate minidumps when

exceptions (including Run-Time System errors) occur within user applications.
• When defining XA resources in the MMC UI of Enterprise Server for .NET, region names are now

restricted to a maximum of eight characters.

File Handling

Back to the list

• The IMS recovery process is now working as expected; previously, a scan of the transaction log was
incorrectly resetting the integrity flag of the files logged.

2821280 (1099615)
• You now receive an RC16 error message, if a PDSM file is missing from a list of concatenated DD's.

2821187 (1099770)
• Indexed files are no longer corrupted when their file size limit is reached.

2817599 (1099359)
• When lock mode is set to 'automatic', with single record locking, the lock from the previous operation is

released at the start of the next file operation; this is to avoid an ABBA deadlock situation occurring.

2816981 (1099052)
• A new file handler configuration file option (STRICTLSEQ) has been added. Only use this option if

instructed to by Support.

2814458 (1099019)
• RM and ACU files accessed from Enterprise Developer no longer crash with a 114 error for I/O

operations on a non-existent optional file opened for input. An appropriate error code is now returned.

2809718 (1098141)
• MFSORT now takes the record length from a previous output file, if its record length is specified, rather

than defaulting to the value in the SORTIN statement.

2808188 (1098243)
• The rollback recovery process is now working as expected.

2802180 (1097066)
• This release provides a new format of the dataset allocation override rules file that supports multiple

conditions.

2783138 (1095007)
• The ACUFH interface between the MF File Handler and the RM File Manager will no longer report an

05 status (optional file created) to more than one COBOL run unit for creation of the same file. The 05
status will be reported to the COBOL run unit that actually created the file. The RM File Manager that
runs under ACUFH and the Micro Focus File Handler for Enterprise Developer now includes
optimizations that enable it to use pread and pwrite system calls and to report status 99 (record locked)
quicker. These optimizations match the optimizations added to the RM File Manager within RM/COBOL.
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• The file handler configuration file (extfh.cfg) now supports the following options:

• ACUFH=ON/OFF - enables or disables any calls to ACUFH. ON by default.
• ESACUFH=ON/OFF - enables or disables calls to ACUFH while running under Enterprise Server.

OFF by default.

Note: As a result of this change, calls to ACUFH are now disabled by default when running under
Enterprise Server.

• In a JCL job executing in Enterprise Server for .NET, the DISPLAY from a second program in the same
step now displays as expected in the SYSOUT for that step; previously, it did not.

• Copying an ESDS file no longer causes an RTS114 error.

2811583 (1098244)
• When a file is closed under Enterprise Server, the file's details are correctly removed from Fileshare.

Previously, some details were not removed.

2810549 (1098111)
• When handling indexed files, the correct .IDX file is now being processed.

2803247 (1097279)
• A return-code (from the call to callrb) and the file-status is now returned when using JCL to add an

alternate index to a file.

2800520 (1096852)

• During a SORT operation, the DYNALLOC parameter is now parsed, but ignored.

2818757 (1099320)
• A Run-Time System error 114 could occur when passing the sort control card continued onto the next

line.

2818291 (1099152)
• The formatting of COUNT to BINARY (BI) is now supported in MFSORT.

2811581 (1098245)
• A SOC4 error no longer occurs when running a SORT operation containing a large number of

conditions.

2803518 (1099559)
• ICETOOL no longer abends when SORTIN is directed to DUMMY and a physical file is missing.

2790053 (1095812)

HCO for Microsoft SQL Server

Back to the list

• The DISCARDDN option is now enabled.

(608200)

IBM Language Environment for OS/390 and VM Support

Back to the list

• The Language Environment utilities are now available as Java managed code.

2826067 (1100134)
• Mainframe Language Environment support (LE Services) is now available in Micro Focus Visual

COBOL and COBOL Server.

2799388 (1097806)
• The Language Environment functions CEEGMT, CEEUTC and CEELOCT now return the number of

seconds to millisecond precision.
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2796098 (1098276)
• The I-S-Info field of the Language Environment (LE) Feed-Back group has been changed from a pointer

to a PIC S9(9) BINARY item.

IDE

Back to the list

• Adding a new "Web Form using Master Page" item to a Web project now works correctly in Visual
Studio versions 2012 or later.

2815524 (1098743)
• When converting a Net Express project that does not contain any executable targets (exe, lib or dll), the

Net Express Project Import wizard now creates a project that holds the application-level dependencies
so they get copied into the main output directory.

2815290 (1098720)
• If, after using the Compile command from the file context menu in Solution Explorer to compile a

COBOL file in your project, you use Compile to compile an IMS file, the IDE no longer recompiles the
COBOL file.

2809825 (1098153)
• It is now possible to debug a 64-bit core dump from a 64-bit native Mainframe Subsystem Application

project.

2804416 (1097366)
• When using a COBOL Web Site project that references a COBOL assembly, the editor may have

incorrectly shown syntax errors even though a build would have succeeded.

2804043 (1097341)
• When adding a new WPF item that contained both XAML and COBOL partial classes to a project, the

code editor used the wrong source format for the COBOL part of the code.

2800293 (1096909)
• In a Micro Focus INT/GNT project that is configured to package the output as an .lbr, the .lbr file will

now include any files in the projects that have their Build Action property set to Content.

2799868 (1096821)
• Setting an SQL compiler directive on a project that contains a Windows Form prevented the IDE from

opening the form in Design view.

2612622 (1094509)
• The Light Bulbs feature in Visual Studio 2015 replaces Smart Tags. Light Bulbs provide functionality

similar to the one Smart Tags provided in previous versions of Visual Studio. The COBOL Smart Tags
(in Visual Studio 2012 and 2013) and the Light Bulbs feature (in Visual Studio 2015) now provide limited
support for managed COBOL language features including interfaces, attributes and generic types.
Other improvements include support of these features within inline copybooks as well as various
performance and stability improvements.

• Saving temporary COBOL projects in Visual Studio now works as expected.
• It is now possible to publish SQL Database projects that target a version of the .NET Framework later

than version 4.0 and when your machine is configured to use the Japanese locale.
• Under certain circumstances, Show All Copybooks failed to expand inline copybooks.
• When debugging, if you attempt to query the value of an unassigned linkage item you are now

prompted to allow memory to be allocated for that item.
• An issue with the colorization of some string literals has been resolved.
• The Namespace Smart Tag now supports managed COBOL language features including interfaces,

attributes and generic types, can be used within inline copybooks, and has had a number of other
performance and stability improvements.

• When debugging COBSQL programs in applications that compile to .int or .gnt files, the caret position is
now set correctly.
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• Adding a new "Web Form using Master Page" item to a Web project now works correctly in Visual
Studio versions 2012 or later.

• Under some conditions when editing a COBOL source file, the editor ignored the source format set in
the project's properties and treated the file as fixed format.

• An issue where new files added to a managed project were not included in the build has been fixed.
• The Namespace Smart Tag now supports managed COBOL language features including interfaces,

attributes and generic types, can be used within copybooks shown inline in the editor, and has a
number of performance and stability improvements.

• When editing .NET managed COBOL in the editor, if referencing a class member that matches a
COBOL reserved word (for example, my-str::Length), the member is now correctly identified and has
the correct color and IntelliSense functionality.

• While debugging, clicking on a line containing a COPY statement or stepping into a copybook which
was part of a program which had not been previously opened could result in an unpredicted behavior.

• If you set the warning level in a project to include recoverable errors (Level E), this setting is now
enforced when building the project and you no longer receive warnings and informational messages in
the build output or in the Error List window.

• The 'Set explicitly no SQL' setting in the properties of COBOL files now works correctly for the Oracle
Pro*COBOL and XDB preprocessors.

• The file extension filters included in the Save File As dialog for COBOL programs now work correctly.
• IntelliSense suggestions now correctly include MS Office Interop types.

IMS Support

Back to the list

• The DLI Interface Block (DIB) was invalid after a path retrieval call from an EBCDIC EXEC DLI
application.

2818159 (1099146)
• Following an IMS Database Control warm restart, IMS failed to return a 'DX' status code on delete of a

logical parent.

2812447 (1098364)
• An IMS database that uses a system generated /SX field to make its secondary index unique was

limited to 4GB in size. This was due to a 4-byte RBA used to construct an /SX field. A new DBD
generation directive, SXRBAFORMAT, allows for control of system generated /SX fields. For details, see
the SXRBAFORMAT topic in your online help. In addition, DBD generation now supports
KEYCOMPRESSION and DATACOMPRESSION directives.

2807747 (1097733)
• A new feature, the IMSLOCK DD statement, has been added as an alternative to the LOCALDLI feature

set by the ES_IMS_LOCALDLI environment variable. To use this new feature, omit the
ES_IMS_LOCALDLI environment variable, and add the IMSLOCK DD statement to job steps that
require LOCALDLI behavior as follows: //IMSLOCK DD * (locking-parm) /* Where (locking-parm) is one
of: EXCLUSIVE – Batch only. Equivalent to LOCALDLI. Requires exclusive. Access to DB – Does not
allow GO sharing. Highest performance batch. SHAREDGO – Batch only. Shared Get Only (dirty read).
Default.

2803155 (1097200)
• Documentation for the MFDBUJCL utility has been updated to include syntax and an example for

executing the Rebuild utility from JCL.

2579603 (1084678)
• When using IMSLOCK EXCLUSIVE (LOCALDLI) feature, an incorrect DB position could result when a

GET-NEXT call follows a PCB switch where a second PCB accessed the same IMS database.

(613461)
• When using the IMS database editor, a database open error sometimes resulted in process termination.
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(607437)

• When a PFKEY executes an IMS /FOR command, the screen will be cleared prior to being formatted.

2825736 (1100207)
• Leading null input segments no longer cause incorrect behavior of a transaction.

2817693 (1099329)

• An EXEC DLI program that specified a symbolic checkpoint (SYMCHKP) call but did not include any
AREAs failed to compile.

(612244)
• The presence of superfluous parentheses in the EXEC DLI PCB keyword caused errors. These

parentheses are now ignored.

(612721)

• Connections by the same user from more than one terminal caused incorrect behavior.

2824846 (1100164)
• The /DISPLAY USER command sometimes failed to recognize valid usernames.

2817244 (1098959)
• IMS applications using 3270 datastream optimization erroneously changed values in the screen buffer.

2814267 (1098667)
• An IMS ACB error no longer causes a Run-Time System error RTS200.

2809817 (1098004)
• MQ-IMS Bridge messages with little-endian encoding are now supported.

2803805 (1097573)
• The /DIS USER command did not remove messages from the message queue. The /DEQUEUE USER

command is now available to remove messages from the message queue.

2781608 (1095370)

Interface Mapping Toolkit

Back to the list

• The Interface Mapping Toolkit was not properly recognizing 64-bit applications, and would not generate
64-bit DLL files.

2792065 (1096292)
• Creating and editing service interfaces now works as expected if you have Visual COBOL (or Enterprise

Developer) for different versions of Visual Studio installed on the same machine.

2792066 (1095977)

JCL Support

Back to the list

• This release provides a number of enhancements to the ESMAC spool view:

• Specifying a large page number and clicking "<" (previous page) displays the current page. Similarly,
typing a large page number and pressing ">" (next page) opens the last page if the page number you
specified does not exist. Previously, the product abended with an RTS 114 in both scenarios.

• The total number of pages has been removed from the ESMAC spool view in order to improve the
display performance of this page. - A new button, "go", enables you to navigate to a specified page.
If you specify a page number that does not exist, this opens the last page.

• If you are viewing the last page, clicking ">" (next page) opens the first page. Clicking "<" (previous
page) when the spool view shows the first page, will redisplay the first page.
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2829135 (1100722)
• Security check for user access to CANCEL.* resource is now made only if the queried job is in the

ACTIVE queue. Previously it was being made for jobs in all queues. This was not necessary as jobs on
queues other than the ACTIVE queue CANNOT be cancelled.

2828492 (1100393)
• Previously, on the JES spool screen in ESMAC, if an automatic refresh was set up, the screen would

revert to displaying the contents of the Output queue after a refresh even if the radio button for another
queue was selected and showing as enabled on the screen.

2785064 (1095144)

• Within ESMAC, jobs in INPUT queues are now deleted correctly.

2828372 (1100382)
• Under mainframe emulation, opening a virgin file I-O now correctly returns a 3/5 status.

2827755 (1100327)
• JCL validation has changed to allow parentheses when assigning a symbolic parm on a PROC

statement without enclosing the string in quotes; for example, the following is now allowed: //PROCBAD
PROC DISP=(,CATLG)

2824260 (1099915)
• Submitting an empty file to the JCL internal reader no longer causes an error.

2813939 (1098593)
• JCL PARM statements containing symbolics that are split over multiple lines are now passed correctly.

2811692 (1098262)
• The environment variable MF_SPOOL_ARCHIVE_LOC, which sets the location for the contents of the

MVS SPOOL spool file to be copied prior to deletion, can now be set to a value with or without a trailing
slash.

2811289 (1098730)
• A syntax error in the SET statement no longer causes ESMAC to hang.

2809821 (1098106)
• A problem with the CTF tracing of mvscatio during region shutdown, which caused exceptional

termination of processes, has been corrected.

2809071 (1098043)
• Data sets with a normal disposition of PASS and an abnormal disposition of CATLG are no longer

removed incorrectly.

2790099 (1095773)
• An error in the allocated data set information returned by MFJCTLBP has been corrected.

2788775 (1095585)
• Spool datasets with the same DD name, which are created in the same job but from different steps with

the same step name, will now be archived as expected, and will create unique entries in the archive
index file.

2786077 (1095243)
• When DSNALI is called with the function parameter DISCONNECT, it will also close the connection.

2780333 (604544)
• The file status is now correctly displayed as "9/009" when the JES "Default Allocated Dataset Location"

setting is set to a directory that does not exist.

2693298 (1093619)
• A problem with the MVSP0027 spool archive process, which was causing spool records to be removed

without archiving them, has been corrected.

2677631 (1092956)
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• Previously, the allocation override processing produced an uppercase path for the first rule in the file.

2836531 (1101338)
• SSTM jobs are now displayed correctly in ESMAC in the JES > SPOOL > ACTIVE list.

2813588 (1098501)
• You no longer receive a memory error in the catalog program produced when using Fileshare to access

VSAM files with large record sizes.

2807110 (1097830)
• To decrease the amount of memory used when processing CICS spool datasets in an SSTM region,

you can now use a new environment variable, ES_JES_FREE_SSTM_SYSOUT, and set it to "Y".

2660637 (1091980)
• The MFELXA file is now removed when the spool housekeeping is executed and the spool files are in a

non-default location.

2659555 (1097267)
• The rules file used for overriding the location for creating datasets has a new format that enables you to

use specific names, define conditions on them and to define multiple conditions. See your product help
and the sample "JCL - Allocation Override" in the Mainframe Samples for more details. The older file
format is still supported so there is no need to change any existing configuration files.

(601709)

• Trying to open an input of an empty ESDS file now correctly results a 3/5 error.

2824959 (1100323)
• Using the LISTCAT LVL command under IKJEFT01 now returns a condition code of 4 for empty GDG

base entries. When using PROF NOPREFIX, LISTCAT LVL lists the GDG base and the step ends with
COND CODE of 0.

2796751 (1096433)

• The use of a PATH entry in VSAM Shareoptions, which previously resulted in an error, has now been
corrected.

2827366 (1100286)
• When asking for file information for an input file to a JCL SORT step, an 'access denied' error is no

longer produced.

2824933 (1100014)
• An error when running an ICETOOL statement, where multiple steps were causing a file locked error to

be returned due to the files not being closed at end of step, has been fixed.

2822169 (1099656)
• The incorrect removal at the end of a job, of a cataloged PASS'd data set, has been corrected.

2822144 (1099644)
• IEBGENER now pads LSEQ files with spaces rather than with low values.

2813760 (1098521)
• When concatenating SYSUT1 data sets, the validation of logical record lengths is now working as

expected.

2810787 (1098246)
• Mainframe SORT emulation now adheres to the rules of the environment variable

MFJ_INPUTDS_ERROR.

2803524 (1097176)
• A MVSCATPB call to functions DLET, REN, or REPL, with a DSNAME of nulls no longer causes the

catalog to become corrupt.

2793169 (1096127)
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• If a concatenated data set has an LRECL of zero, then the LRECL value of the previous file in the
concatenation is used.

2660492 (1090627)
• IEBDG has been corrected to process an empty input file with a return code of 0.

2607628 (1088100)
• When MF_DEL_DYNPDS=Y, deleting the entire dynamic PDS now deletes all members and also the

directory folder.

2567645 (1088706)
• A problem that produced an RTS 114 error when tracing the IDAEFT01 module has been corrected.

(607893)

• REPRO for ALTERNATE INDEXES and PATHS is treated as a "NO-OP", because it is not appropriate
for the underlying physical structure of the Micro Focus files.

2800292 (1096872)
• A new option when performing IDCAMS REPRO allows the bypass of the pristine file state (Error

JCLAM0150S) and the REPRO to produce an empty output file: set the environment variable
MFJ_REPRO_EMPTY=Y.

2790606 (1095968)
• A problem causing the truncation of a catalog listing to 100 VSAM clusters has been corrected.

2654125 (1090116)
• IDCAMS now processes the TSO ALLOCATE(xxx) COPY(yyy) command correctly, where the yyy data

set is a VSAM data set.

2581587 (1096352)

• The ON condition processing has been changed in order to avoid generating "IF <conditon> GOTO"
label statements before every EXEC statement.

2787049 (1095670)

Library

Back to the list

• Using a dd_ environment variable to specify the path used in CBL_LOCTE_FILE now works as
expected.

2822153 (1099632)

Mainframe Access

Back to the list

• A new parameter, /ENDLOG=<endlogPath>, has been added to the MFDAS Endevor commands. If an
endlogpath is specified and the Endevor command fails, the transaction log is downloaded to the
specified location.

2814266 (1098581)
• The FS_CHECK_FILE_EXIST routine no longer deletes the data set being checked on a mainframe.

(608326)

• MFMONMX.exe now returns a non-zero return code when it encounters an error.

2814298 (1098677)
• If the "Delete workstation file if mainframe member is deleted" option in the advanced synchronization

options of Mfmonmx2 is checked, mfmonmx2 now successfully executes the operation. Deleting an
entire directory on the mainframe is also synchronized.
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• An occasional abend U0996, which occurs when the MFA Endevor job starts, should no longer occur.

2828402 (1100415)
• You no longer receive an error message "Unknown return code 9/64" when importing copybook

members in Source Connect.

2809371 (1097999)
• The MFDAS EXPORT PAN commands now work correctly.

2805251 (1097867)
• MFA server now supports CA Endevor R17.

2800686 (1096931)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client, used by COBOL Web Service proxies and other components, now
allows HTTP URLs with certain characters such as ":". It also no longer rejects correct URLs with "%xx"
escape sequences.

2828629 (1100520)

Micro Focus Communications Server

Back to the list

• An issue with leaked sessions for IMS Connect conversations has been corrected.

2797552 (611154)
• Certain Enterprise Server administration actions such as notifying a running enterprise server of a

security update could cause MFCS to hang.

2784219 (1095045)

Micro Focus Directory Server

Back to the list

• The generated HTML fragment displayed for an individual resource entity element when using the
Enterprise Server Administration HTML GUI to administer an external Security Manager was
overflowing a fixed size buffer. This is now allocated based on the actual length required.

2828732 (1100545)
• Corrected the resource entity that the Enterprise Server Administration GUI checks to determine

whether the external Security Manager administration pages are accessible to a logged on user. The
correct resource entity is "User Administration" under the "Enterprise Server Administration" resource
class.

2828553 (1100539)
• Require read permission before returning repository data for authenticated users if MFDS is started with

the -b option.

2828228 (1100364)
• Access to password data is prevented on the security manager edit page in the Enterprise Server

Administration HTML GUI.

2827942 (1100333)
• When MFDS is secured using an external Security Manager, it does not display internal security

configuration pages which no longer have an effect.

2827786 (1100314)
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• Correct display of user session data in the Enterprise Server Administration HTML GUI.

2826210 (1100161)
• An issue with the persistency of the audit output option in the MF Directory Server security configuration

has been resolved.

2824201 (1099902)
• Honor the trace flags values set in an Enterprise Server XML configuration file when importing it into

MFDS via the -g command line option.

2823855 (1099846)
• An issue with storing certificate passphrase in the Enterprise Server Administration HTML GUI form

data has been resolved.

2820846 (1099448)
• The resistance of the Enterprise Server Administration HTML GUI log-on page to cross-site scripting

attacks has been increased.

2819223 (1099212)
• Improve browser caching control to increase security of the Enterprise Server Administration HTML

GUI.

2819218 (1099209)
• An issue with storing certificate passphrase in the Enterprise Server Administration GUI has been

resolved.

2819212 (1099207)
• The Enterprise Server Administration web page makes additional authorization checks before

displaying screens.

2819069 (1099192)
• The Enterprise Server Administration web page no longer displays sensitive session data.

2818974 (1099178)
• Password length restriction has been fixed in the Enterprise Server Administration login page.

2818973 (1099179)
• Enterprise Server Historical Statistics Facility (HSF) configuration can now be exported and imported

via the mfds -x and -g command-line options.

2815030 (1098695)
• Previously, the Enterprise Server Administration journal export to text truncated the exported file.

2802793 (1097108)
• It is now possible to expand and collapse items within the tree view of the external security manager

security resources in Enterprise Server Administration.

2801421 (1096979)
• The MFDS GUI now correctly displays external Security Manager resource ACL strings that are greater

than 3K byte length.

2800727 (1096978)
• The MFDS -x XML export option was not exporting Windows Monitoring and Management configuration

values for enterprise server instances.

2794382 (1096428)

Micro Focus Server Administrator (GUI)

Back to the list
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• If access to Enterprise Server Administration is restricted by use of an MLDAP ESM-based external
Security Manager, you can now configure a user to have access to the "Security" menu item but not to
the "Options" menu item.

2804728 (1097916)
• Previously, when expanding or collapsing items in the tree view for external Security Manager within

Enterprise Server Administration, items associated with a user or a group no longer would always move
to the top of the resource list.

2803399 (1097848)
• If MFDS is configured to use an external Security Manager with the Windows "user" class, it is not

possible to edit the users from the MFDS GUI and you receive a warning.

MLDAP API Interface

Back to the list

• The MLDAP ESM module now recognizes a wider range of errors that indicate that the specified LDAP
server is unavailable and, if configured, the server will retry to establish a connection.

2799921 (1098128)
• The MFDS GUI and the ESFADMIN utility now display the pages with LDAP query results.

2681539 (1092705)

Monitoring and Management

Back to the list

• The HSF records for JCL STEPs could contain incorrect values for IMS, SQL and API fields because
they were not initialized for each STEP. This has been fixed.

2830910 (1100672)

PL/I Support

Back to the list

• Specifying -optexec plitest for a program that uses more than one EXEC language (such as SQL, CICS
and DLI) now works as expected and generates or activates only one instance of the CodeWatch
debugger.

2783575 (1094972)
• The CICSDEMO Open PL/I sample application has been updated to provide a demonstration of both

32-bit (X86) and 64-bit (X64) projects and execution environments.

(609689)

• The ROUND built-in function now works with FIXED BINARY data.

2830667 (1100641)
• A problem with initial repetition factors not working for the GRAPHIC and WIDECHAR data types has

been fixed.

2830665 (1100640)
• A problem with the RANDOM built-in function has been fixed.

2830364 (1100611)
• A problem with ALLOCATE CTL EXTERNAL has been fixed.

2828211 (1100361)
• A problem with the DECIMAL built-in function when the second and third arguments (precision and

scale) are both omitted has been fixed.
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2827872 (1100326)
• A problem when the second and/or third arguments of the SUBSTR built-in are expressions of result

type fixed bin (31) has been fixed.

2825937 (1100124)
• A problem with automatic initializers containing function calls with star-extent parameters has been

fixed.

2825936 (1100123)
• A new compilation option, -rc, enables you to set the minimum error code level 0, 4, 8 which results in a

zero return (successful compilation).

2822734 (1099721)
• A problem with multiple allocate statements of a based variable with initializers resulting in the compiler

warning MFPLI00121W ("fewer values than are required to initialize the variable") has been fixed.

2821140 (1099524)
• A problem has been fixed with the ALLOCATE statement where CONTROLLED items with variable-

sized extents are evaluated at the execution of the ALLOCATE statement.

2818212 (1099406)
• Previously, if a user program was compiled with -range and using the VERIFY() builtin function on a

zero length string with an omitted starting position argument, STRINGRANGE was incorrectly raised.
This has now been fixed.

2815832 (1098780)
• A problem with the REPEAT and COPY built-in functions when the repeat string is of constant length >

1 has been fixed.

2813416 (1098487)
• A problem when appending diagnostic messages to listing file resulting in a compiler I/O abort has been

corrected.

2806933 (1097641)
• The PL/I compiler no longer crashes for some cases where a function returning a CHAR VARYING

value is used as an argument.

2802889 (1097127)
• The NONASSIGNABLE attribute is now diagnosed as not yet supported.

2800777 (1096900)
• String truncation is now diagnosed when the target string is shorter than the source string in an

assignment statement or INITIAL clause.

2800745 (1096898)
• A function without a return statement is now diagnosed.

2799526 (1096718)
• DEFAULT RANGE storage and alignment attributes are no longer applied to named constants.

2795076 (1096300)
• A problem causing error 2000A when using the construct: TRIM(STRUCTURE), BY NAME ; has been

fixed.

2788933 (1095606)
• A problem with ALLOCATE in an AREA variable based on a pointer returned by a function invocation

has been fixed.

2787752 (1095450)
• The Open-PL/I compiler now supports the %INCLUDE statement syntax: %include

LIBRARYNAME(FILENAME); If LIBRARYNAME is used, it is ignored. The above statement is
equivalent to: %include FILENAME; and the rules used for the compiler options -ipath and -isuffix are
applied.
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2691090 (1093644)
• A problem causing Error MFPLI00109S when passing a controlled structure containing arrays as an

argument has been fixed.

2680705 (1092894)
• The compiler option -zalign has been added for Z/OS structure mapping behavior. This feature is in

Early Adopter Product (EAP) release status.

2675882 (1092102)
• Problems with the order of block prologue initialization of automatic variables have been fixed.

2675382 (1092043)
• -fdmaxp available in ED 2.2 U2 now provides the requested arithmetic precision functionality.

2614820 (1088014)
• The compiler now diagnoses BASED variable declarations which contain both REFER-extents and

other extents with non-constant values.

(610382)
• The CONNECTED and NONCONNECTED attributes are now accepted on the DEFAULT statement.

(607463)

• If a hex literal was embedded in a non Macro IF/THEN, where the "THEN" invoked a macro procedure
to generate its source, the "X" that terminated the hex literal was split across a %SDEBUG; which
caused the source to no longer compile. This no longer happens.

2802841 (1097112)
• Previously if utilizing a FIXED variable in a preprocessor macro in an expression without a comparison

operator such as =, <, > in an IF statement with the bitwise OR ("|"), an incorrect result was returned.
For example: %IF PLI_64BIT | SYSOS = "WIN" THEN The behavior was also exhibited if a similar
expression was used as an assignment into a macro preprocessor variable. This has now been fixed.

(610534)

• Previously, a warning message occurred about sprintf used in systemcics.o when linking a PL/I CICS
application with the most strict unresolved external warnings enabled. This no longer occurs.

2831590 (1100755)
• Previously a SYSPRINT output via stream I/O in an EBCDIC ES Region with a program compiled with -

EBCDIC resulted in an ASCII output to the EBCDIC file.

2828418 (1100384)
• A fix for RPI 1092067 caused a regression in the processing of input datasets assigned to a DUMMY

DD via JCL.

2813471 (1098494)
• A previous enhancement made to provide support for DD DUMMY without any DCB specified in the

user program or in the JCL broke the behavior when a fixed length file was created using JCL that
contained no DCB information about the DD statement. This has now been fixed.

2804948 (1097350)
• Previously, if you compiled your code with -range and used the INDEX built-in function without the

optional third parameter and a string with zero length, it would incorrectly raise the STRINGRANGE
condition. This no longer happens.

2804815 (1097359)
• The user can use an environment variable of the form DCB_ddname, where ddname equates to the

PL/I file variable name, to specify the record length and format of the file. See the PL/I User's guide for
more information.

2588122 (1085972)
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• When using the DELAY() built-in function, and executing such that the output displayed via an
XWindows Server, XWindows sometimes interrupted the process via a signal, preventing the delay
period from fully elapsing.

(611125)

• EXEC SQL (or EXEC DLI or EXEC CICS) statements may now span across multiple include members
and may start anywhere (including primary source file) and end anywhere (including primary source
file). Such statements can also be debugged using the debugger successfully and correctly.

2824293 (1099907)
• GRAPHIC and WIDECHAR data types are now supported in PL/I SQL.

2809520 (1097905)
• The DB2 pre-compiler no longer requires setting the DB2(UDB-VERSION) directive when compiling

against DB2 z/OS server.

2799215 (1096688)
• Previously, when two consecutive EXEC SQL INCLUDE statements were made with no intervening

logic and when each one of these statements started and terminated with a larger comment, an error
occurred in the tokenizing phase. As a result, any EXEC SQL logic contained in the second INCLUDE
was missed and not preprocessed.

2797042 (1096728)
• SQL embedded within PL/I macro code included via EXEC SQL INCLUDE is now supported.

2605681 (1087117)

RM/COBOL

Back to the list

• The RM File Manager for Enterprise Developer now provides a mechanism for avoiding RM indexed file
corruption while debugging in managed code.

In Enterprise Developer for Eclipse, to avoid file corruption, you need to manually set the environment
variable RMFM_PRETEND_FORCE_CLOSED to YES in the Debug Configuration.

Enterprise Developer for Visual Studio is preconfigured to avoid file corruption. If necessary, you can
also specify the RMFM_PRETEND_FORCE_CLOSED variable in a project's Application Configuration
File (App.config).

See your product help for more details.

2796890 (1096699)

Run-Time System

Back to the list

• A run unit created with the RuntimeServices RunUnit class no longer causes an exception to occur if no
COBOL code has been executed inside it before the RunUnit is terminated with a StopRun() method.

2826239 (1100198)
• You now receive a correct error code when the product does not find a file located on a network drive.

2822161 (1099619)

• The RM/COBOL version of the “SYSTEM” library routine nows supports the return of an exit-code, for
native COBOL applications.

2830238 (1100599)
• On a 32-bit Enterprise Server running on Windows, tasks that are blocked in the operating system can

now be canceled without terminating the SEP process.
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2807997 (1097918)
• An error in generated code when initializing comp-2 data items from fractional literal values has been

fixed.

2800938 (1096960)
• The tunables default_cancel_mode and subsystem_cancel_mode both have a new setting, which

enables programs to remain in memory after they are canceled; this is opposed to the default behavior,
which physically removes .dll files and shared objects from memory when they are canceled.

2690881 (1096628)

SQL: COBSQL

Back to the list

• The COBSQL preprocessor generated an error when it encountered a host variable declared as "01 HV
PICTURE S9(9) VALUE ZERO COMP."

2826093 (1100163)
• COBSQL now honors the position of the $SET statements in copybooks that are expanded inline in the

editor by the CP preprocessor.

2825364 (1100308)
• COBSQL examined hostvars in commented lines, causing compilation errors.

2824211 (1099928)
• CCOBSQL now processes COPY... REPLACING COBOL data items' level correctly.

2813839 (1098531)
• The COBSQL preprocessor inserted a NULL character in front of each non-printable character, causing

errors when processing Pro*COBOL (i.e., when COBSQLTYPE=ORACLE8).

2809551 (1097939)
• COBSQL did not always correctly handle COPY... REPLACING with text exceeding the 72 column.

2809404 (1097890)
• COBSQL incorrectly handled COPY... REPLACING when the level numbers of data items in the

copybook were being replaced.

2807898 (1097765)
• COBSQL was not recognizing the DECLARATIVES statement in some scenarios.

2804183 (1097346)
• COBSQL now processes COPY...REPLACING statements correctly.

2779818 (1094538)

SQL: DB2 ECM

Back to the list

• The HCO DCLGEN tool sometimes generated inappropriate values for REAL and DOUBLE columns in
PL/I copybooks.

2831022 (1100684)
• The DB2 ECM incorrectly generated code to process SET CURRENT PACKAGE PATH, resulting in

SQLCODE -4952 when executed.

2817342 (1098963)
• HCO incorrectly handled .bnd files. The new DB2(BINDDIR) directive resolves this issue.

2815734 (1098893)
• The DB2 ECM preprocessor incorrectly generated COBDB0103S errors when a fixed CHAR host

variable was defined as greater than 254 characters.
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2803193 (1097169)
• When FILLER was used in group host variable structure, the DB2 ECM raised an SQL4914 error.

2802547 (1097091)

SQL: HCO for SQL Server

Back to the list

• The OpenESQL pre-compiler no longer incorrectly swaps a colon and blank inside a literal if compiled
with HCOSS directive SQL(DIALECT=MAINFRAME), which was resulting in a -305 SQL error when
executed.

2822809 (1099757)
• The OpenESQL preprocessor generated incorrect connection information when compiling with the

SQL(INIT) AND CHARSET(EBCDIC) directives.

2814325 (1098596)
• The OpenESQL preprocessor sometimes erroneously returned SQLCODE error code 1, NULL value

returned but no indicator variable supplied, when it encountered a stored procedure call.
• DLL files for 64-bit aliases for DSNTEP2 and DSNUTILB were not available, and have been added in

this release: 64-bit DSNTEP2 alias DLL: sqltp264.dll 64-bit DSNUTILB alias DLL: sqlutb64.dll. Use
these in JES alias-program mappings.

SQL: OpenESQL

Back to the list

• When compiling for ODBC, the OpenESQL preprocessor failed to generate correct SQL code for some
large SQL statements.

2832617 (1100892)
• When compiling a WCF Service application with the SQL(DBMAN=ADO) directive, the OpenESQL

preprocessor attempted to generate SQL interface code, resulting in a COBCH002 error.

2827979 (1100367)
• The GetHire stored procedure sample showed that a COBOL CLR stored procedure could cause an

exception to be thrown when using stored procedure definition files, and when compiled without
SQL(DIALECT=MAINFRAME).

2827854 (1100318)
• Run-time exceptions sometimes resulted from dynamic COBOL calls in stored procedures.

2819325 (1099263)
• The OpenESQL runtime sometimes generated an index out of range error on SQL statements in

managed applications when the PID generated by the OpenESQL preprocessor for each method was
not unique.

2815075 (1098749)
• A problem where a stored procedure that uses DIALECT=MAINFRAME could throw an exception if the

HCOSS stored procedure remapping table had not been deployed to the database has been fixed.

2809927 (1097972)
• The OpenESQL preprocessor did not support SELECT statements coded with a colon (:) on host

variables after the INTO clause for ORACLE PROCOB migration applications.

2596427 (1086198)
• The OpenESQL preprocessor has been enhanced to allow the use of PIC S9(5) COMP-5 host variables

for INTEGER data on programs migrated from Pro*COBOL.

2596426 (1086197)
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• When using SQL(DATE=EXTERNAL) with Oracle, timestamp values were formatted incorrectly. This
has been change to correctly format timestamp values according to the setting of
NLS_TIMESTAMP_FORMAT.

2596425 (1086196)
• When SQL(PROCOB) is set, Oracle date and timestamp result types fetched into PIC X(n) host

variables are truncated without warning.

2596424 (1086195)
• An SQLCODE incompatibility existed between Pro*COBOL and OpenESQL ADO.NET. This has been

corrected. Setting SQL(PROCOB) now also sets SQL(CHECKSINGLETON). When SQL(PROCOB) is
set, OpenESQL error codes in the SQLCA are converted to Pro*COBOL-compatible error codes, which
are controlled by a new file, mfpcocds.txt. This file is delivered in %ProgramData%\Micro Focus
\SQLCODES by default.

2595728 (1087599)
• The OpenESQL runtime for ADO.NET returned times using a 12-hour clock. It now returns times using

a 24-hour clock.

• For managed-code projects, PF_RO_CURSOR and other BEHAVIOR primitive directives were not
available from the User Interface.

2833926 (1101049)
• Some problems related to using ASSOCIATE with the Host Compatibility Option for SQL Server where

the stored procedure name was supplied in a host variable have been fixed.

2831480 (1100747)
• HCO with SQL Server (HCOSS) using the ADO.NET run-time system exhibited a problem retrieving

result set locators on the second call and subsequent calls to a stored procedure.

2830688 (1100659)
• The SQL CLR wrapper program generated by the Generate SPD File tool caused errors during

deployment when it contained one or more data types exceeding 8000 bytes in size. To eliminate these
errors, the Generate SPD File tool now generates the SQL CLR wrapper program with MAX SIZE = -1.

2830545 (1100650)
• PIC X host variables passed to the server as variable-length data with trailing blank suppression

sometimes caused OpenESQL to return different query results than some earlier versions of this
COBOL development product.

2829810 (1100685)
• When generating a COBOL wrapper program, the Generate SPD File tool did not support the passing

of all parameters for a SQL CLR Stored Procedure definition routine as fixed length. To resolve this, a
new option, GENFIXEDLENGTH, has been added.

2829499 (1100629)
• A number of issues with PostgreSQL record logic and error handling have been fixed in OpenESQL's

run-time systems for ODBC and ADO.NET.

2828058 (1100338)
• When the SQL(PROCOB) directive is set, OpenESQL for ADO.NET now supports anonymous PL/SQL

blocks and the following host variable types: SQL-CURSOR SQL-ROWID SQL-BFILE SQL-BLOB SQL-
CLOB SQL-NCLOB

2825199 (1100003)
• When compiling with the SQL(PROCOB) directive, the OpenESQL preprocessor sometimes generated

incorrect SQL code when a host variable reference in COBOL was split over multiple lines.

2825194 (1099997)
• When using the SQL(CHECK) directives with SQL TYPE CLOB host variables, compilation sometimes

failed.
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2819480 (1099342)
• Windows GUI projects compiled with the SQL compiler directive might throw a

MicroFocus.COBOL.Program.COBOLStopRunException on GOBACK.

2816463 (1098907)
• The insertion of more that 8000 characters into a SQL Server VARCHAR(MAX) column from a PIC X(n)

host variable caused a data truncation error.

2814679 (1098675)
• When SQL(TARGETDB=ORACLE) was set and the FOR UPDATE clause was used to enable row

locking, this combination could sometimes trigger a runtime failure. SQL(TARGETDB=ORACLE) is no
longer required to enable row locking via FOR UPDATE clauses on queries.

2814613 (1098624)
• A 114 error on DISCONNECT sometimes occured due to a long-standing bug in Oracle ODBC drivers.

This release provides a workaround. The ODBC specification states that the ODBC row status array is
an array of 2-byte integers, but some Oracle ODBC drivers from Oracle 11 onwards have been
observed to use either 4-byte or 8-byte integers. The OpenESQL runtime for ODBC now automatically
detects the element size used by the driver when an Oracle connection is opened, and adapts its
behavior accordingly.

2813428 (1098480)
• OpenESQL now supports OUTPUT clauses in SQL Server INSERT, UPDATE, and DELETE

statements. HCO for SQL Server now supports the DATA-CHANGE-TABLE-REFERENCE clause.

2812940 (1098424)
• An SQLCA error message occurred when inserting a record into a table using a SQL CLR stored

procedure with a VARCHAR (max) column where the host variable was more than 8000 bytes.

2812261 (1098390)
• The OpenESQL preprocessor incorrectly generated a COBES0100 error when compiling code that

contained GEN-GV-FROM-GROUP and the same host variable used multiple times in same SQL
statement.

2811682 (1098231)
• The OpenESQL preprocessor reported an error for LOCK TABLE statements encountered when using

an Oracle database with the SQL(CHECK) compiler directive option.

2808579 (1097797)
• When using the SQL compiler directive option to compile a program that contained no SQL statements,

a 153 trap occurred when the OpenESQL preprocessor encountered SQLCODE defined as COMP.

2808076 (1097758)
• The OpenESQL preprocessor sometimes generated a "COBCH0302 IF....ELSE or scope-delimiter

mismatch" error if a program defined SQLCODE separately as COMP.

2807937 (1097702)
• The OpenESQL preprocessor sometimes generated a STOP RUN rather than a GOBACK at the

program end, which sometime caused improper termination for subroutines not coded with one or more
GOBACK statements.

2807272 (1097624)
• The OpenESQL preprocessor produced a COBES0125 or COBES0112 error message when it

encountered indicator variable arrays used with non-host array variables.

2805207 (1097457)
• COBOL SQL CLR stored procedures can now open connections to other databases using EXEC SQL

CONNECT statements. For type 6 CONNECT statements, this requires using a post-deployment script
to alter the connection string for the OpenESQL runtime such that it runs with EXTERNAL_ACCESS
privilege. For other CONNECT statement formats, INSAFE privilege is required. Use SQL Server
authentication rather than Windows authentication for external connections.
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2804010 (1097230)
• In some situations, the OpenESQL pre-compiler incorrectly generated a COBES0125 error, "<variable>

should be defined with an OCCURS clause".

2802029 (1097036)
• The ODBC ECM incorrectly generated swap logic for COMP fields on singleton SELECTs in managed

applications which could result in field corruption if the variable was used in a WHERE clause.

2801806 (1097049)
• The OpenESQL Assistant generated copybooks using the same size for DATETIME2 columns

regardless of their definitions. The OpenESQL Assistant now generates PIC X(26) for DATETIME2(6),
and PIC X(29) for all other DATETIME2 definitions.

2799778 (1096776)
• A problem that affected the use of 'select *' in OpenESQL subqueries has been fixed.

2799720 (1096751)
• A problem with array fetches into PIC N NATIONAL host variables has been fixed in the ODBC run-time

system for OpenESQL.

2799002 (1096790)
• The OCI run-time now handles the NULL indicator correctly when running in 64-bit mode.

2792566 (1096149)
• OpenESQL for JDBC now supports positioned updates with PosgreSQL.
• The THREAD SQL compiler directive option mishandled threads in certain scenarios.
• In certain scenarios, OpenESQL incorrectly handled host variables defined as SQL TYPE DBCLOB

when inserting or fetching DBCS data.
• OpenESQL for JVM now supports spaces between the start of an ODBC, JDBC, date, time or

timestamp escape marker and its associated date, time or timestamp literal string when the
SQL(DETECTDATE) directive is set.

• Use of the tinyint (pic s99 comp-5) host variable sometimes resulted in bad code generation for some
OpenESQL runtime systems. Tinyint is now fully supported on all OpenESQL runtime systems.

• The OpenESQL run-time now truncates DBCS character strings cleanly at a whole character boundary.
• Using CHARSET(EBCDIC) in a DBCS locale caused problems with the OpenESQL runtime systems for

ADO and JDBC. This has been corrected by changing the behavior to be consistent with the ODBC
runtime. In particular, SO/SI characters are now correctly inserted and removed for EBCDIC and ASCII
data respectively.

• The one-phase ODBC switch module now handles commit and rollback API calls from applications and
uses DSNRLI correctly, together with handling of global temporary tables by HCOSS applications.

SQL Option for DB2

Back to the list

• The XDB ECM precompiler option GRANT-EXECUTE"NONE" will now be picked up so that the static
bind utility skips performing a GRANT after a successful bind operation.

2816862 (1099030)
• Sometimes, the XDB pre-compiler incorrectly generated an COBCH0002S error message, "Undefined

ECM error, error code 309". This has been fixed.

2827471 (1100376)

• The XDB Link no longer returns SQLCODE -501, "THE CURSOR IDENTIFIED IN A FETCH OR
CLOSE STATEMENT IS NOT OPEN", when running against mainframe DB2V8 locations with SQLAM
level 7.

2810688 (1098123)
• Support for code point CCSIDXML has been limited to SQLAM level 8 and above so that you no longer

receive an error L30073 for the client.
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2810166 (1098034)
• Dependence on outdated XDB Link configuration files has been removed.

2803118 (1097147)
• The XDB ODBC Driver has been modified to use the newer-format XDB error message files.

• A complex set of conditions caused UNION clauses to omit rows.

2829690 (1100541)
• You no longer receive an X352 access violation error during compound index optimization of complex

queries.

2824820 (1100759)
• VARCHAR FOR BIT DATA items could cause data conversion errors. To resolve this, the JDBC driver

now receives errors on SYSTEM location access.

2815915 (1098918)
• Previously, the XDB Optimizer marked a LIKE predicate as ALWAYS TRUE during a compound index

search which resulted in too many rows appearing in the results.

2815394 (1098853)
• XDB Server no longer reports a message "Command not implemented" when creating an index using

the reserved word DOCUMENT.

2807906 (1097716)
• UPDATE statements containing a SET clause with a scalar-subselect parameter caused an X352 server

violation error.

2804775 (1097348)
• XDB used the incorrect UNION of data types integer and decimal, and incorrectly correlated table

expressions for data retrieval.

2798097 (1096617)
• An ORDER BY clause using a name with name(field) inside of an expression in a projection list has

been fixed.

2793635 (1096110)
• When executing a DELETE CURSOR with ROWSET and using a decimal host variable to indicate the

rowset row number, the row was not deleted from the table.

2660884 (1090705)
• Unexpected behavior occurred when processing a query with a T.* expression in a projection list if its

CHAR/VARCHAR elements were always described as FOR BIT DATA.
• Unexpected behavior occurred when processing a query with an ORDER BY clause with a T.*

expression in the projection list.

• When using the MFDB2UNL utility, the SELECT statement had to start at column 1. This restriction has
now been removed.

2695319 (1095955)
• Unexpected behavior sometimes occurred when working with host variables that were explicitly

declared to be in a CCSID.

2452020 (1074507)
• During an install or uninstall, SQL Option for DB2 sometimes issued an X028 Cannot find table

sysibm.syslocations message.

(612443)
• Queries on tables with NOT NULL columns were generated incorrectly.

• The SQL wizard no longer crashes when selecting a data type while creating or altering a table.

2816786 (1098964)
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• It is now possible to copy data from cells of a read-only table using a context menu option.

2597630 (1086397)

XML Extensions

Back to the list

• The XML model file must be accessible to the XML extensions run-time environment. To make the file
accessible, either add it to the system path, or move it to the directory from which the program is run.

2822399 (1099702)

XML Support

Back to the list

• XMLPARSE no longer reports an error if a prefix is not properly declared and no validation is specified.

2823420 (1099786)
• The Compiler no longer errors preprocessed lines containing non-ASCII characters in the indicator

area. Previously, this could cause user programs using the htmlpp preprocessor to fail to compile.

2805067 (1097977)
• The XML I/O run-time used to read the whole document into memory which caused an out-of-memory

error.

2801337 (1096999)
• The namespace prefix in the namespace declaration is now handled correctly when the element itself

does not contain a prefix.

2799691 (1098150)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, mfsupportinfoII, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfoII.exe is stored in <install-dir>\bin.

To run mfsupportinfoII:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfoII at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2015. All rights reserved.
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